Contents

Contents 3

Preface 7

Introduction to VMware Converter 9
  Migration with VMware Converter 9
  VMware Converter Editions 10
  Cloning and System Reconfiguration of Physical Machines 10
    Hot and Cold Cloning 11
    Local and Remote Cloning 11
      Example of Remote Hot Cloning 11
      Example of Local Cold Cloning 13
    Cloning Modes 14
      Volume-Based Cloning 14
      Disk-Based Cloning 15
  Migrating Existing Virtual Machines and System Images 15
    Converting Virtual Machines 15
    Configuring Virtual Machines 15
  Managing Tasks 15
  What’s New for Customers of P2V Assistant and Virtual Machine Importer 16
    For Users of VMware P2V Assistant 16
    For Users of VMware Virtual Machine Importer 16

System Requirements 17
  Application Requirements 17
  Memory Requirements for Cold Cloning 18
  Physical Machines That Can Be Imported 18
  Virtual Machines and System Images That Can Be Imported 18
  Supported Destinations 19
  How Converting Affects Settings 19
    Changes to Virtual Hardware 20
  TCP/IP Ports Required by VMware Converter 20

Installing and Uninstalling VMware Converter 21
  Installing VMware Converter 21
  Uninstalling, Modifying, or Repairing VMware Converter 22
  Installing VMware Converter to Run in Install-Less Mode 23
  Adding a License 23
  Performing a Scripted Install 23

Importing Machines with VMware Converter 25
  Selecting the Procedure for Your Import 25
    Importing in Install-Less Mode 25
    Cold Cloning a Physical Machine 25
  Determining the Procedure to Follow 26
  Starting the Wizard for a Conversion 26
  Step 1: Selecting Your Source 27
Selecting a Physical Machine as the Source 27
Selecting an ESX Server Virtual Machine as the Source 28
Selecting a Standalone Virtual Machine as the Source 29
Step 2: Choosing a Destination for the New Virtual Machine 30
  Importing Your Source Machine as an ESX Server Virtual Machine 31
  Importing Your Source Machine as a Workstation Virtual Machine 32
Step 3: Customizing the Guest Operating System of the New Virtual Machine (optional) 34
Completing the Import Task Creation 36

Using the Converter Boot CD for Local Cold Cloning 37
  Cold Cloning and the Converter Boot CD 37
  Starting the Wizard for a Conversion 37
Step 1: Selecting Your Source Data 38
Step 2: Choosing a Destination for the New Virtual Machine 39
  Importing Your Source Machine as an ESX Server Virtual Machine 39
  Importing Your Source Machine as a Workstation Virtual Machine 40
Step 3: Customizing the Guest Operating System of the New Virtual Machine (optional) 40
Completing the Import Task Creation 42
Using peTool to Modify the Converter Boot CD 42

Configuring VMware Virtual Machines 45
  Starting the Configuration 45
    Starting the Wizard and Getting to Source Selection 45
    Selecting an ESX Server Virtual Machine as the Source 45
    Selecting a Standalone Virtual Machine as the Source 46
  Customizing the Guest Operating System of the New Virtual Machine (optional) 46
  Completing the Configuration 48

Managing Tasks 49
  Multiple Tasks 49
  Task View 49
    Task List 49
    Toolbar 50
  Details View 51
    Summary Tab 51
    Task Progress Tab 51
  Starting and Canceling Tasks 52
    Starting a Task from the Task View (Forcing a Queued Task to Run) 52
    Cancelling a Task 52
    Deleting a Task 52
  Looking at Progress and the Logs 53
    Viewing a Task’s Progress 53
    Exporting and Viewing the Log 53
  Editing Tasks 53
    Editing a Task 53
    Editing a Failed Task 54
  Managing How Tasks Run 54
    Controlling the Number of Tasks Running Concurrently 54
    Changing the Run Order 55
    Changing the Number of Tasks Displayed in the Task List 55
    Changing Which Tasks Are Displayed in the Task List 55
Glossary 57

Index 65
Preface

This preface provides information about the *VMware Converter User’s Manual* and links to VMware® technical support and educational resources.

**About This Book**

This manual, the *VMware Converter User’s Manual*, provides information about installing and using VMware Converter.

**Revision History**

This manual is revised with each release of the product or when necessary. A revised version can contain minor or major changes.

<table>
<thead>
<tr>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20061228</td>
<td>VMware Converter 3.0 documentation to accompany the initial release of the product.</td>
</tr>
</tbody>
</table>

To view the most current version of the manual, see the VMware Web site:


**Intended Audience**

This book is intended for anyone who needs to install, upgrade, or use VMware Converter. VMware Converter users typically include people who do software development and testing or work with multiple operating systems or computing environments: software developers, QA engineers, trainers, salespeople who run demos, and anyone who wants to create virtual machines. Another set of users includes anyone who needs to non-intrusively copy and transform physical systems into VMware virtual machines, either locally or remotely.

**Document Feedback**

If you have comments about this documentation, submit your feedback to:

docfeedback@vmware.com


Conventions

The following typographic conventions are used in this manual.

<table>
<thead>
<tr>
<th>Style</th>
<th>Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>blue boldface (online only)</td>
<td>Cross-references and links</td>
</tr>
<tr>
<td>Monospace</td>
<td>Commands, filenames, directories, and paths</td>
</tr>
<tr>
<td>Monospace bold</td>
<td>User input</td>
</tr>
<tr>
<td>Italic</td>
<td>Document titles, glossary terms, and occasional emphasis</td>
</tr>
<tr>
<td>&lt; name &gt;</td>
<td>Variable and parameter names</td>
</tr>
</tbody>
</table>

Technical Support and Education Resources

The following sections describe the technical support resources available to you.

Self-Service Support

Use the VMware Technology Network (VMTN) for self-help tools and technical information:

- Product information – http://www.vmware.com/products/
- Technology information – http://www.vmware.com/vcommunity/technology
- Documentation – http://www.vmware.com/support/pubs
- VMTN Knowledge Base – http://www.vmware.com/support/kb
- Discussion forums – http://www.vmware.com/community
- User groups – http://www.vmware.com/vcommunity/usergroups.html

For more information about the VMware Technology Network, go to http://www.vmtn.net.

Online and Telephone Support

Use online support to submit technical support requests, view your product and contract information, and register your products. Go to http://www.vmware.com/support.

Customers with appropriate support contracts should use telephone support for the fastest response on priority 1 issues. Go to http://www.vmware.com/support/phone_support.html.

Support Offerings

Find out how VMware support offerings can help meet your business needs. Go to http://www.vmware.com/support/services.

VMware Education Services

VMware courses offer extensive hands-on labs, case study examples, and course materials designed to be used as on-the-job reference tools. For more information about VMware Education Services, go to http://mylearn1.vmware.com/mgrreg/index.cfm.
Introduction to VMware Converter

VMware Converter provides an easy-to-use, scalable solution for migrations of machines, both physical to virtual and virtual to virtual. Optimized for mass migration, VMware Converter is equally effective for single-machine conversions. With its comprehensive wizards and task manager, VMware Converter imports virtual machines faster, with fewer manual steps required and fewer source hardware limitations than other methods. With its ability to hot clone, Converter can import a new virtual machine with no downtime on its source physical machine.

VMware Converter combines and expands the functionality available in the VMware products P2V Assistant and Virtual Machine Importer. It eases interoperability among VMware hosted products (Workstation, ACE, VMware Server, and VMware Player), VirtualCenter- managed ESX Server 3.x and 2.5.x, and unmanaged ESX Server 3.x.

This chapter includes the following sections:

- “Migration with VMware Converter” on page 9
- “Cloning and System Reconfiguration of Physical Machines” on page 10
- “Migrating Existing Virtual Machines and System Images” on page 15
- “Managing Tasks” on page 15
- “What’s New for Customers of P2V Assistant and Virtual Machine Importer” on page 16

Migration with VMware Converter

With VMware Converter you import virtual machines from different source formats into one of several VMware product destinations. Use the application to:

- Convert physical machines for use across different VMware product formats.
- Convert virtual machines for use across different VMware product formats.
- Move virtual machines across different VMware product platforms.
- Create VMware virtual machines from third-party formats like Symantec Backup Exec System Recovery (formerly LiveState Recovery), Norton Ghost, and Microsoft Virtual Server and Virtual PC.
- Reduce the time needed to populate new virtual machine environments.
- Migrate legacy servers to new hardware with no need to reinstall operating systems or application software.
- Perform migrations across heterogeneous hardware.
- Proactively readjust disk sizes, types, and partitions to maximize utilization of storage resources.
- Start and manage multiple concurrent migrations.
- View audit trail.
VMware Converter creates and migrates VMware ready virtual machines from a broad range of sources.

**VMware Converter Editions**

VMware Converter comes in two editions, Starter and Enterprise, to meet the particular need of different users and use cases.

**Table 1-1. Differences Between Starter and Enterprise Editions**

<table>
<thead>
<tr>
<th></th>
<th>VMware Converter Starter</th>
<th>VMware Converter Enterprise</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment</td>
<td>Designed for single migrations to VMware product such as Virtual Infrastructure 3, VMware Player, VMware Workstation, and VMware Server</td>
<td>Designed for multiple concurrent migrations to Virtual Infrastructure 3</td>
</tr>
<tr>
<td>License</td>
<td>Free download</td>
<td>Licensed as a part of SnS (Support and Subscription) with VirtualCenter Management Server.</td>
</tr>
<tr>
<td>Cloning</td>
<td>Local hot cloning to hosted products (Workstation, VMware Player, GSX Server, VMware Server) and ESX Server; remote hot cloning to hosted products only</td>
<td>Local hot cloning to hosted products and ESX Server; remote hot cloning to hosted products and ESX Server; local cold cloning (Converter Boot CD) to hosted products and ESX Server</td>
</tr>
<tr>
<td>Job management</td>
<td>Single migration at a time Task editing</td>
<td>Multiple, concurrent migrations. Task editing</td>
</tr>
</tbody>
</table>

**Cloning and System Reconfiguration of Physical Machines**

Cloning is the process of creating a cloned disk, where the cloned disk is a virtual disk that is an exact copy of the source physical disk. This involves copying the data on a physical source machine's hard disk and transferring that data to a target virtual disk (the new cloned disk). System reconfiguration is the process of adjusting the migrated operating system to enable it to function on virtual hardware. This adjustment is performed on the target virtual disk after cloning and enables the target virtual disk to function as a bootable system disk in a virtual machine.

The VMware Converter wizard outputs a completely new VMware virtual machine based on a source physical machine. The migration process is nondestructive, so you can continue to use the original source machine.
However, if you plan to run an imported VMware virtual machine on the same network as the source physical machine, you must modify the network name and IP address on one of the machines, so the physical and virtual machines can coexist properly.

### Hot and Cold Cloning

VMware Converter supports hot cloning or cold cloning. *Hot cloning*, also called live cloning or online cloning, entails cloning the source machine while it is running its operating system. *Cold cloning*, also called offline cloning, entails cloning the source machine when it is not running its operating system. In cold cloning the user reboots the source machine from a CD that has its own operating system, from which the VMware Converter application runs. Cold cloning leaves no footprint on the source machine.

### Local and Remote Cloning

For *local cloning*, the migration is performed with the application running on the source machine. With *remote cloning*, the source machine can be accessed without having to physically touch it, as long as it is running.

#### Example of Remote Hot Cloning

Here are illustrations that show the general steps followed by VMware Converter after a user has set up a migration task using the converter wizard available on the application. All the steps in the illustrations are automated. They are performed by Converter without operator involvement after the user has created the task with the wizard. This is an example of hot cloning, in which the physical machine being cloned experiences no downtime.

**Remote hot cloning of a physical machine**

![Diagram of remote hot cloning](image)

**Figure 1-2.** Initial state of source and destination machines.
Figure 1-3. Preparing the source machine for a conversion.

1. The Converter installs the agent on the source machine.
2. The Agent takes a snapshot of the source volumes.

Figure 1-4. Preparing the virtual machine on the destination machine.

3. Converter creates a new virtual machine on the destination machine.
4. The Agent copies volumes from the source machine to the destination machine.

Figure 1-5. Completing the conversion process.

5. The Agent installs the required drivers to allow the operating system to boot in a virtual machine.
6. The Agent personalizes the virtual machine (for example, changing the IP information).
Converter removes all traces from the source machine.

**Example of Local Cold Cloning**

Here are illustrations that show the general steps followed by VMware Converter after a user has set up a migration using the converter wizard available on the Boot CD. After the user has booted from the Converter Boot CD and used the application on it to direct the course of the migration, the remaining steps are performed by Converter without operator involvement until rebooting the source machine to return to its original operating system.

**Local cold cloning of a physical machine**

1. User boots the source machine from the Converter Boot CD and uses VMware Converter to define and start the migration.
2. Converter copies the source volumes into a RAM disk.
Figure 1-9. Preparing the virtual machine on the destination machine.

3 Converter creates a new virtual machine on the destination machine.

4 Converter copies volumes from the source machine to the destination machine.

Figure 1-10. Completing the conversion process.

5 Converter installs the required drivers to allow the operating system to boot in a virtual machine.

6 Converter personalizes the virtual machine (for example, changing the IP information).

Figure 1-11. Cleaning up.

7 User removes Boot CD and reboots the source physical machine to return it to its own operating system. The virtual machine is ready to run on the destination machine.

Cloning Modes

VMware Converter implements two cloning modes: disk-based cloning and volume-based cloning.

Volume-Based Cloning

VMware Converter supports volume-based cloning for hot and cold cloning and for importation of existing virtual machines. In volume-based cloning, all volumes in the destination virtual machine are basic volumes, regardless of the type in the corresponding source volume. Some types of source volumes are unsupported and are skipped during cloning.
Levels of support:

- Hot cloning supports all types of source volumes.
- Cold cloning (Converter Boot CD) supports all types of dynamic volumes, but doesn’t support Windows NT 4 fault-tolerant volumes.
- Virtual machine importing supports basic volumes and all types of dynamic volumes except RAID. It doesn’t support Windows NT 4 fault-tolerant volumes. Only Master Boot Record (MBR) disks are supported. GUID Partition Table (GPT) disks are not supported.

Disk-Based Cloning

Converter supports disk-based cloning for cold cloning and for importation of existing virtual machines. Disk-based cloning transfers all sectors from all disks, preserving all volume metadata. The destination virtual machine receives exactly the same volumes, of the same type, as those of the source virtual machine. Disk-based cloning supports all types of basic and dynamic disks.

Migrating Existing Virtual Machines and System Images

The VMware Converter wizard outputs a new VMware virtual machine based on a source virtual machine or system image. The migration process is nondestructive, so you can continue to use the original source virtual machine or system image with the product used to create the source virtual machine. To run an imported VMware virtual machine on the same network as the source virtual machine, modify the network name and IP address on one of the virtual machines so that the original and new virtual machines can coexist.

Converting Virtual Machines

VMware Converter lets you move VMware virtual machines between Workstation, VMware Player, ESX Server, GSX Server, and VMware Server. It also imports virtual machines from Microsoft Virtual Server and Virtual PC.

Configuring Virtual Machines

For VMware virtual machines whose disks have been populated by restoring from a backup of a physical host or by some other direct means of copying, VMware Converter prepares the image to run on VMware virtual hardware.

Managing Tasks

VMware Converter provides a task manager as a new, robust tool for managing migrations. This can be for a single import or for multiple, concurrent migrations. After you create a task using the converter wizard to set up how you want to import a machine, use the Task View of the manager to:

- Start or stop an import
- Change the run order
- Force a queued task to run
- Control the number of jobs running simultaneously
- Filter the view of what tasks are displayed
- Edit a task
- View a task’s progress
- Cancel a task
- Edit and restart a failed task
- Delete a task
- View an audit trail
What’s New for Customers of P2V Assistant and Virtual Machine Importer

VMware Converter expands the functionality available to users of P2V Assistant and Virtual Machine Importer. Here are some of the new features and capabilities you get when using VMware Converter.

For Users of VMware P2V Assistant

In moving from P2V Assistant to VMware Converter, you see more options and abilities in migrating physical machines, along with the new ability to migrate virtual machines.

VMware Converter provides:

- Single, central management console to easily deploy, manage, and schedule conversions without the need for a Helper virtual machine.
- New hot cloning functionality for cloning a physical machine while it is running, with zero server downtime for the source system.
- Local cold cloning functionality using the bootable VMware Converter Boot CD, with a broader range of supported source operating systems.
- Remote cloning to remove the need to walk to and physically interact with each physical machine.
- Custom tool for adding additional Windows drivers to the Converter Boot CD ISO image.
- Broad hardware support for physical machines as compared to the previous generation P2V Assistant product.
- Block-based cloning to enable significantly faster cloning speeds than P2V Assistant 2.x file-based cloning.
- Fewer manual steps for conversion as compared to P2V Assistant.

Converter supports:

- Multiple simultaneous conversions for a higher degree of scalability.
- Cloning a wide variety of Windows operating system platforms including Windows XP, Windows Server 003, Windows 2000, Windows NT 4 (SP6 +), and 64-bit Windows Support (Windows XP and Windows Server 2003).
- Conversion of standalone VMware virtual machine disk formats (VMware Player, VMware Workstation, VMware GSX Server and VMware Server) across all VMware virtual machine platforms (including ESX Server 3.x and VirtualCenter 2.x managed servers as target host).
- Conversion of third-party disk image formats such as Microsoft Virtual PC, Microsoft Virtual Server, Symantec Backup Exec System Recovery (formerly LiveState Recovery), and Norton Ghost 9 (or higher) to VMware virtual machine disk format.

For Users of VMware Virtual Machine Importer

In moving from Virtual Machine Importer to VMware Converter, you see more options and abilities in migrating virtual machines, along with the new ability to migrate physical machines.

VMware Converter provides:

- Single, central management console to easily deploy, manage, and schedule conversions.
- Multiple simultaneous conversions for a higher degree of scalability.
- Local hot cloning of physical machines for live migrations with zero server downtime for the source machine.
- Remote hot cloning of physical machines.
- Image customization feature for modification of the virtual machine’s guest operating system properties after the conversion.
This chapter describes the requirements to be fulfilled before operating VMware Converter and describes the compatibilities and interoperabilities among the systems on which and with which it works.

The chapter includes the following sections:

- “Application Requirements” on page 17
- “Memory Requirements for Cold Cloning” on page 18
- “Physical Machines That Can Be Imported” on page 18
- “Virtual Machines and System Images That Can Be Imported” on page 18
- “Supported Destinations” on page 19
- “How Converting Affects Settings” on page 19
- “TCP/IP Ports Required by VMware Converter” on page 20

### Application Requirements

VMware Converter and its Agent run on the following Microsoft Windows operating systems:

- Windows NT SP6+ (with IE5 or higher)
- Windows 2000
- Windows 2003 32-bit and 64-bit
- Windows XP Professional 32-bit and 64-bit

VMware Converter can run in virtual machines that use the above as guest operating systems.

**NOTE** Although VMware Converter operates on Windows only, after the migration you can transfer the virtual machine to the VMware-supported host platform of your choice.

For configuring virtual machines, or for importing third-party images and VMware hosted product virtual machines, the operating system on which Converter runs must be equal to, or greater than, the operating system on the source machine, as shown in Table 2-1.
Table 2-1. Operating system compatibility for configuring, importing VMware hosted products, or importing third-party images.

<table>
<thead>
<tr>
<th>Operating system on source machine</th>
<th>Compatible operating systems on the system running VMware Converter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2000</td>
<td>X</td>
</tr>
<tr>
<td>Windows XP</td>
<td>X</td>
</tr>
<tr>
<td>Windows 2003</td>
<td>X</td>
</tr>
</tbody>
</table>

Space information and requirements for installation:
- Installer size – 24MB
- Installed files – 73MB
- Minimum boot drive requirement (if installed on boot drive) – 120MB
- Minimum boot drive requirement (if installed on another drive) – 105MB

The VMware Converter Boot CD runs on its own copy of Windows Preinstallation Environment (WinPE).

Memory Requirements for Cold Cloning

For cold cloning with the VMware Converter Boot CD (see Chapter 5, “Using the Converter Boot CD for Local Cold Cloning,” on page 37), the source physical machine must meet certain memory requirements.

The minimum memory requirement on the physical machine for running Converter Boot CD is 264MB. The recommended memory is 364MB.

Table 2-2. Memory requirements for cold cloning with the Boot CD

<table>
<thead>
<tr>
<th>If the source physical machine’s memory (m) is</th>
<th>Then the Boot CD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Less than 264MB</td>
<td>Cannot perform a cold clone.</td>
</tr>
<tr>
<td>Greater than or equal to 264MB but less than 296MB</td>
<td>Can perform a cold clone, but cannot use a RAM disk.</td>
</tr>
<tr>
<td>Greater than or equal to 296MB but less than 364MB</td>
<td>Can perform a cold clone with a RAM disk, although using network share is suggested. The RAM disk size is m minus 264MB.</td>
</tr>
<tr>
<td>Greater than or equal to 364MB</td>
<td>Can perform a cold clone with a RAM disk. The RAM disk size is m minus 264MB, up to a limit of 124MB.</td>
</tr>
</tbody>
</table>

Physical Machines That Can Be Imported

VMware Converter can hot clone and reconfigure any physical machine running an operating system noted in the previous section, “Application Requirements.”

For a cold clone, the VMware Converter Boot CD can be started from, and clone, machines fitted out with storage controllers and network adapters that Microsoft lists as supported in Windows 2003. With this requirement met, Converter can clone machines running operating systems noted in the previous section.

Virtual Machines and System Images That Can Be Imported

VMware Converter can import virtual machines created with:

- Workstation 5.x and Workstation 4.x
- VMware Player 1.x
- ESX Server 3.x
- ESX Server 2.5.x (if the virtual machine is managed with VirtualCenter 2.x)
VMware Converter can import system images from Symantec Backup Exec System Recovery (formerly LiveState Recovery) and Norton Ghost version 9 and higher.

Note the following limitations:
- Virtual machines must be powered off before you import them. You cannot import suspended virtual machines.
- Virtual machines from Macintosh versions of Virtual PC are not supported.
- The operating system on the source Virtual PC or Virtual Server virtual machine must be a Windows guest operating system supported by the intended VMware platform (for example, VMware Workstation 4 or 5). See the VMware Web site for a list of supported operating systems: [http://www.vmware.com/support/guestnotes/doc/index.html](http://www.vmware.com/support/guestnotes/doc/index.html)

VMware Converter supports Virtual PC and Virtual Server virtual machines with most Windows operating systems prior to Windows NT 4.0 for cloning only. It does not support configuring for machines with earlier Windows operating systems.

**Supported Destinations**

VMware Converter can output virtual machines that are compatible with:
- Workstation 5.x and Workstation 4.x
- VMware Player 1.x
- ESX Server 3.x
- ESX Server 2.5.x (support only by importing through a VirtualCenter 2.x server that manages the ESX Server)
- GSX Server 3.x
- VMware Server 1.x
- VirtualCenter 2.x

**How Converting Affects Settings**

The VMware virtual machine created by the Converter contains an exact copy of the disk state from your source physical machine, virtual machine, or system image, with the exception of some hardware-dependent drivers (and sometimes the mapped drive letters). Settings from the source computer that remain identical include:
- Operating system configuration (computer name, security ID, user accounts, profiles and preferences, and so forth)
- Applications and data files
- Each disk partition’s volume serial number
Because the target and the source virtual machines or system images have the same identities (name, SID, and so on), running both on the same network can result in conflicts. To redeploy the source virtual machine or system image, ensure that you do not run both the source and target images or virtual machines on the same network at the same time.

For example, if you use VMware Converter to test the viability of running a Virtual PC virtual machine as a VMware virtual machine without first decommissioning the original Virtual PC machine, you must resolve the duplicate ID problem first. You can resolve this problem by using the optional customization step in VMware Converter Manager.

## Changes to Virtual Hardware

Most migrated applications should function correctly in the VMware virtual machine because their configuration and data files have the same location as the source virtual machine. However, applications might not work if they depend on specific characteristics of the underlying hardware such as the serial number or the device manufacturer.

When troubleshooting after virtual machine migration, notice the following potential hardware changes:

- CPU model and serial numbers (if activated) can be different after the migration. They correspond to the physical computer hosting the VMware virtual machine.
- Ethernet adapter can be different (AMD PCNet or VMXnet) with a different MAC address. Each interface’s IP address must be individually reconfigured.
- Graphics card can be different (VMware SVGA card).
- Numbers of disks and partitions are the same, but each disk device can have a different model and different manufacturer strings.
- Primary disk controllers can be different from the source machine’s controllers.
- Applications might not work if they depend on devices that are not available from within a virtual machine.

## TCP/IP Ports Required by VMware Converter

Table 2-3 lists the ports Converter uses in the conversion process.

<table>
<thead>
<tr>
<th>Communication Paths</th>
<th>Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converter application to remote physical machine</td>
<td>445 and 139</td>
</tr>
<tr>
<td>Converter application to VirtualCenter Server</td>
<td>902</td>
</tr>
<tr>
<td>Converter application to ESX Server 3.x</td>
<td>902</td>
</tr>
<tr>
<td>Physical machine to VirtualCenter Server</td>
<td>902</td>
</tr>
<tr>
<td>Physical machine to ESX Server 3.x</td>
<td>902</td>
</tr>
</tbody>
</table>

If your VirtualCenter Servers or ESX Servers are configured to listen on port 905, you will have to make adjustments accordingly.
This chapter describes the basic steps for installing VMware Converter, for both the Starter and Enterprise editions.

The chapter includes the following sections:
- “Installing VMware Converter” on page 21
- “Uninstalling, Modifying, or Repairing VMware Converter” on page 22
- “Installing VMware Converter to Run in Install-Less Mode” on page 23
- “Adding a License” on page 23
- “Performing a Scripted Install” on page 23

Installing VMware Converter

You can install VMware Converter onto a physical machine or virtual machine. The typical setup installs both VMware Converter and its VMware Converter Agent. However, you can choose a custom installation to install one or the other component by itself.

To install VMware Converter

1. Make sure the Converter system requirements have been met. See “System Requirements” on page 17.
2. Download the latest version of VMware Converter from the VMware Web site: [http://www.vmware.com](http://www.vmware.com)
3. To start the installer, go to the folder that contains the installer file you downloaded and double-click the file: `VMware-p2v-3.x.x-<xxxxx>.exe`
   In this example, `<xxxxx>` is the name of the build. This file is on the application CD or in the local directory to which you downloaded the installer.
   
   A Preparing to Install dialog box appears momentarily and the VMware Converter installation wizard opens with a Welcome page.
   
   If you have an older version of the application installed on the machine, you must uninstall it. In this case, before the Welcome page appears, a dialog box appears asking if you want to uninstall the previous version. Click Yes to continue. Click No to exit the installation wizard.
4. Click Next on the Welcome page.
5. In the End-User License Agreement page, select I accept the terms in the License Agreement, and click Next.
6 Select the location folder for VMware Converter in the Destination Folder page and click Next. The default location is C:\Program Files\VMware\Converter. To install in another location, click Change and browse for the new location.

7 If you have a VMware Enterprise license, add the license file in the Licensing page and click Next. You can also wait until after installation and enter the information when you have the application running. See “Adding a License” on page 23.

If you are using the Starter edition, you do not need to enter anything.

8 Select a Typical installation or Custom installation and click Next.

9 In the Custom Setup page, choose which components to install, either Converter Manager or Converter Agent or both, and click Next.

If you install both components you can manage the import of physical or virtual machines to any authorized location.

If you install only Converter Manager, you can use that machine to import only remote physical machines.

Installing Converter Agent prepares the local physical machine for import. When used with the Converter Manager, it also enables the importation of the full range of machine types.

10 In the Ready to Install the Program page, click Install.

Messages appear that indicate the progress of the installation.

If you click Cancel during the installation, the installed files are rolled back and the operating system is returned to its original state.

11 When the wizard displays the Installation Completed page, click Finish.

The Run VMware Converter now check box is selected by default. To finish installation but not launch the application at this time, deselect the check box before clicking Finish.

If your system is running Windows 2000 or Windows NT and you have installed Converter Agent, you must restart your system before you can use VMware Converter.

Uninstalling, Modifying, or Repairing VMware Converter

In addition to being able to use the Microsoft Windows Add or Remove Programs utility from the control page to uninstall VMware Converter, you can also remove it using the VMware Converter installer wizard.

The installer wizard has the additional capability to allow you to modify or repair VMware Converter.

To uninstall, modify, or repair VMware Converter

1 To start the VMware Converter installer, go to the folder that contains the installer file and double-click the file: VMware-p2v-3.x.x-<xxxxx>.exe

In this example, <xxxxx> is the name of the build. This file is on the Application CD or in the local directory to which you downloaded the installer.

The Converter installation wizard opens with a Welcome page.

2 Click Next.

3 In the Program Maintenance page, select Modify, Repair, or Remove and click Next.

- Select Modify to change the installed components of VMware Converter. This takes you to the Custom Setup page of the wizard, where you can make changes. See Step 9 in “To install VMware Converter” on page 21.

- Select Repair to have the wizard verify and reinstall any damaged components of the Converter.

- Select Remove to uninstall VMware Converter.
4 In the Remove the Program page, you can remove all related files and registry entries created by VMware Converter, and remove the license file for the Enterprise edition if you have it. Click Remove.

Alternatively, if you are modifying or repairing VMware Converter, the page that appears is the Ready to Modify the Program or the Ready to Repair the Program page, without any mention of file deletion.

When the wizard finishes removing or repairing the Converter, you might have to restart your system before you can use VMware Converter. If so, a dialog box appears.

You have finished modifying, repairing, or removing VMware Converter.

**Installing VMware Converter to Run in Install-Less Mode**

You can convert a running remote physical machine without having VMware Converter installed on the machine from which you direct the migration. This is called “install-less mode.” For this you have Converter Manager on a network share, mount it from the system from which you direct the migration, and run the executable from there.

See “Importing in Install-Less Mode” on page 25.

**Adding a License**

If you have not identified a license file for the Enterprise edition when you installed VMware Converter, you can do so later in the application itself.

**To add an Enterprise license**

1. Launch the VMware Converter Manager application by double clicking on the Converter icon.
2. Choose Administration > Licensing Information in the main menu.
3. Click Add License in the License Information dialog box.
4. In the browser, find and select the license file and click Open.
   - If the license is valid, the License Information dialog box shows the expiration date for it.
5. Click Close.

**To change an Enterprise license**

1. Launch the VMware Converter Manager application.
2. Choose Administration > Licensing Information in the main menu.
3. Click Change License in the License Information dialog box.
4. In the browser, find and select the license file and click Open.
   - If the license is valid, the License Information dialog box shows the expiration date for the changed license.
5. Click Close.

**Performing a Scripted Install**

For administrators who want to perform a push install, you can install Converter using Deployment Console. Two Converter jobs, “distribute P2V Installer” and “uninstall p2v,” should be set up as tasks under Job:System Jobs:Config Jobs.

Using distribute p2v installer launches VMware-p2v-3.x.x-<xxxxx>.exe (where <xxxxx> is the name of the build). Use the options listed in Table 3-1.
Table 3-1. Some scripted install command-line options

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>INSTALLDIR=[path]</td>
<td>Denotes path to the installer.</td>
</tr>
<tr>
<td>ADDLOCAL=[feature[,feature. . .]]</td>
<td>Installs the listed features. For Converter, the options are P2VGUI, P2VAgent, and ALL (case sensitive).</td>
</tr>
<tr>
<td>REBOOT=&quot;REALLYSUPPRESS&quot;</td>
<td>If a reboot is required, it will be suppressed.</td>
</tr>
<tr>
<td>/qn</td>
<td>Quiet, no UI.</td>
</tr>
<tr>
<td>/q</td>
<td>Quiet, with progress information, no user interaction.</td>
</tr>
<tr>
<td>PROPERTY=[property value]</td>
<td>Sets the value of property to “property value.”</td>
</tr>
<tr>
<td>REMOTEINSTALL=1</td>
<td>Prevents the installer from being upgraded.</td>
</tr>
<tr>
<td>msiexec /quiet/uninstall {{uninstall key}}</td>
<td>Uninstalls Converter, using the uninstall key for Converter found in the registry. To find the uninstall key: in RegEdit, use the path HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall, choose the top key in the list and use the down arrow until the right pane shows the information for VMware Converter.</td>
</tr>
<tr>
<td>msiexec ?</td>
<td>Lists MSI commands.</td>
</tr>
</tbody>
</table>
This chapter describes how to create a VMware Converter task to import physical machines, virtual machines, and system images from a variety of sources into a variety of destinations using local and remote hot cloning.

For local cold cloning, see Chapter 5, “Using the Converter Boot CD for Local Cold Cloning.”

For configuring virtual machines and system images, see Chapter 6, “Configuring VMware Virtual Machines.”

See Chapter 7, “Managing Tasks” to run the migration after you create the task.

This chapter includes the following sections:

- “Selecting the Procedure for Your Import” on page 25
- “Starting the Wizard for a Conversion” on page 26
- “Step 1: Selecting Your Source” on page 27
- “Step 2: Choosing a Destination for the New Virtual Machine” on page 30
- “Step 3: Customizing the Guest Operating System of the New Virtual Machine (optional)” on page 34
- “Completing the Import Task Creation” on page 36

**Selecting the Procedure for Your Import**

With three categories of source machines and images (physical machine, standalone machine, ESX Server machine), and two categories of destinations (standalone Workstation machine, ESX Server machine), the procedure for your conversion can vary from job to job. Use Table 4-1, “Menu of Procedures for Converting Machines,” on page 26 to find the combination of procedures that matches your source and destination machines.

**Importing in Install-Less Mode**

Install-less mode entails converting a running remote physical machine without having to install the VMware Converter Manager (sometimes called “the GUI”) onto the machine from which you are initiating the migration. To run in install-less mode, temporarily install the Converter Manager on a machine and copy the files in the install directory to a network share. After this you can mount the network share from another machine and run the executable without having to install it on that particular machine.

After starting the Converter Manager from the mounted network share, follow the procedures listed for a remote physical machine as source in Table 4-1, “Menu of Procedures for Converting Machines,” on page 26.

**Cold Cloning a Physical Machine**

See Chapter 5, “Using the Converter Boot CD for Local Cold Cloning,” on page 37 for instructions on using the VMware Converter Boot CD to cold clone a local physical machine.
Determining the Procedure to Follow

Table 4-1 lists the procedures for converting the three categories of sources to the two categories of destinations. Use it to navigate through the combination of procedures specific to your need.

Table 4-1. Menu of Procedures for Converting Machines

<table>
<thead>
<tr>
<th>Source</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware Standalone Virtual Machine (Workstation or VMware Server)</td>
<td>ESX Server or VirtualCenter Server Virtual Machine</td>
</tr>
<tr>
<td>Physical Machine</td>
<td>“Starting the Wizard for a Conversion” on page 26</td>
</tr>
<tr>
<td></td>
<td>“Selecting a Physical Machine as the Source” on page 27</td>
</tr>
<tr>
<td></td>
<td>“Importing Your Source Machine as a Workstation Virtual Machine” on page 32</td>
</tr>
<tr>
<td></td>
<td>“Step 3: Customizing the Guest Operating System of the New Virtual Machine (optional)” on page 34</td>
</tr>
<tr>
<td></td>
<td>“Completing the Import Task Creation” on page 36</td>
</tr>
<tr>
<td>Standalone Virtual Machine¹</td>
<td>“Starting the Wizard for a Conversion” on page 26</td>
</tr>
<tr>
<td></td>
<td>“Selecting a Standalone Virtual Machine as the Source” on page 29</td>
</tr>
<tr>
<td></td>
<td>“Importing Your Source Machine as a Workstation Virtual Machine” on page 32</td>
</tr>
<tr>
<td></td>
<td>“Step 3: Customizing the Guest Operating System of the New Virtual Machine (optional)” on page 34</td>
</tr>
<tr>
<td></td>
<td>“Completing the Import Task Creation” on page 36</td>
</tr>
<tr>
<td>ESX Server or VirtualCenter Virtual Machine</td>
<td>“Starting the Wizard for a Conversion” on page 26</td>
</tr>
<tr>
<td></td>
<td>“Selecting an ESX Server Virtual Machine as the Source” on page 28</td>
</tr>
<tr>
<td></td>
<td>“Importing Your Source Machine as a Workstation Virtual Machine” on page 32</td>
</tr>
<tr>
<td></td>
<td>“Step 3: Customizing the Guest Operating System of the New Virtual Machine (optional)” on page 34</td>
</tr>
<tr>
<td></td>
<td>“Completing the Import Task Creation” on page 36</td>
</tr>
</tbody>
</table>

¹ Includes VMware Workstation, Microsoft Virtual PC and Virtual Server, and Symantec Backup Exec Server Recovery (formerly LiveState Recovery) and Norton Ghost 9 and higher images.

For information on third-party source machines and images supported by VMware Converter, see “Virtual Machines and System Images That Can Be Imported” on page 18.

Starting the Wizard for a Conversion

Follow these steps to start the VMware Converter wizard from the VMware Converter application.

To start the wizard

1. Launch the VMware Converter application.
2. Click Import Machine in the upper left part of the toolbar.
3. Click Next on the Welcome to the VMware Converter Import Wizard page.

The Source page introduces the Table of Contents pane. Converter combines its procedures under three sections (“Steps”): “Step 1: Source,” “Step 2: Destination,” and Step 3: Customization.” When you proceed to a section (“Step”), that section expands to display the names of the pages the wizard leads you through. When you are finished with that “Step” section, the next expands.

Continue with “Step 1: Selecting Your Source” on page 27.
**Step 1: Selecting Your Source**

After you start the wizard, you have three categories to choose from for the source for converting your virtual machine. Depending on your source, go to one of the following sections:

- “Selecting a Physical Machine as the Source” on page 27
- “Selecting an ESX Server Virtual Machine as the Source” on page 28
- “Selecting a Standalone Virtual Machine as the Source” on page 29

**Selecting a Physical Machine as the Source**

Follow these steps if your source system is a local or remote physical machine, or a remote physical machine if you are running in “install-less mode.”.

If the machine is local, you must have installed the VMware Converter Agent on it before starting the conversion.

**To select the source physical machine and choose the disks to import**

1. On the Source page, click Next to go to the Source Type page.

2. Select the **Physical computer** radio button on the Source Type page, and click Next.

3. For a remote machine, type its name or IP address (or choose a machine from the drop-down list). Type the DOMAIN\user name and Password for the remote machine on the Source Login page, and click Next.

   For a local machine, select the **This local machine** button (the authorization is set to the current user in this case and cannot be changed) and click Next.

4. Choose the disks to import by following the remaining steps in this procedure.

   For hot cloning of a physical machine, VMware Converter enables volume-based cloning only.

5. Deselect any volumes you do not want to import.

   If you deselect the system volume or active volume, a warning appears before you go to the next page.
When doing volume-based cloning, Converter normally skips the page and hibernation files, because they are large and do not contain any information that a user would ordinarily want to copy. However, you have the option to not ignore these files. When doing disk-based cloning, Converter cannot provide an option to skip these files.

Specify the volume size you want in the **New Disk Space** drop-down combo box, and click **Next**.

The choices are:

- **Maintain Size** (<size from Total Size column>) – Choose to keep the original volume size.
- **Min[imum] Size** (<size from Used column, plus a little additional>) – Choose to import just the used portion from the volume, with a small amount of space added.
- **<Type Size in GB>** – Choose to enter a specific size in gigabytes.
- **<Type Size in MB>** – Choose to enter a specific size in megabytes.

Typing in a value less than the minimum size results in a warning message.

### Selecting an ESX Server Virtual Machine as the Source

Follow these steps if your source system is a virtual machine from VMware ESX Server or managed by VirtualCenter.

**To select the source ESX Server virtual machine and choose the disks to import**

1. On the Source page, click **Next** to go to the Source Type page.
2. Select the **ESX Server or VirtualCenter virtual machine** radio button on the Source Type page, and click **Next**.
3. On the Source Login page, type in or choose the ESX Server or VirtualCenter Server containing the virtual machine you want to import.

   The **ESX / VC Server** drop-down box is populated with the identifiers or locations of the last 10 systems logged in to. You can type in a new identifier.

   If you chose an ESX Server machine, proceed to the next step. If you chose a VirtualCenter server, go to Step 6.
4 Choose the virtual machine you want to import from the list of those found on the ESX Server machine you logged on to.

5 Click Next and go to Step 7.

6 Specify the source for your virtual machine in the VirtualCenter virtual machine inventory browser, and click Next.

You can search the browser through one of two views of the inventory—the default Hosts & Clusters view or the Virtual Machines & Templates view—in the View drop-down box.

7 To import all disks unchanged, make sure the Import all disks and maintain size radio button is selected on the Source Data page and click Next. Import all disks and maintain size is the only choice if the virtual machine you are importing has a Linux guest operating system.

Otherwise, select the Select volumes and resize to save or add space radio button and follow the remaining steps in this procedure.

8 Deselect any volumes you do not want to import.

If you deselect the system volume or active volume, a warning appears before you go to the next page.

9 Specify the volume size you want in the New Disk Space drop-down combo box, and click Next.

The choices are:
- Maintain Size (<size from Total Size column>) – Choose to keep the original volume size.
- Min[imum] Size (<size from Used column, plus a little additional>) – Choose to import just the used portion from the volume, with a small amount of space added.
- <Type Size in GB> – Choose to enter a specific size in gigabytes.
- <Type Size in MB> – Choose to enter a specific size in megabytes.

Typing in a value less than the minimum size results in a warning message.

Continue with “Step 2: Choosing a Destination for the New Virtual Machine” on page 30.

Selecting a Standalone Virtual Machine as the Source

Follow these steps if your source system is a local or remote standalone virtual machine (that is, one that is a virtual machine from VMware Workstation 4 or 5, VMware Player, VMware Server, VMware GSX Server, Microsoft Virtual PC, Microsoft Virtual Server, or a Symantec Backup Exec System Recovery [formerly LiveState Recovery] or Norton Ghost 9 or higher image).

To select the source standalone virtual machine and choose the disks to import

1 On the Source page, click Next to go to the Source Type page.

2 Select the Standalone virtual machine radio button on the Source Type page, and click Next.

3 Browse for the source virtual machine or image from the Select Virtual Machine page, and click Next.

4 In the file browser select the file for the machine you want to import and click Open.

You can filter the types of files shown by using the Files of type drop-down box. File type choices are:
- VMware Workstation Files (*.vmx, *.vmtn)
- Microsoft Virtual Server Files (*.vmc)
- Symantec Backup Exec System Recovery Files (*.sv2i)
- All Supported Files

The VMware Converter inspects the file.

If the source virtual machine is Windows NT SMP, the VMware Converter might require files from service packs or hot fixes. In this case, the New Virtual Machine Reconfiguration page appears. Otherwise, proceed to Step 7.
NOTE  If you are running VMware Converter on a system running Microsoft Windows 2000 or later, and you are importing a Microsoft Windows NT 4.0 virtual machine or image, a warning message advises that the import process will upgrade any NTFS partitions in the resulting virtual machine to a newer version of the NTFS file system. To avoid upgrading your file system, click No in the dialog box and click Cancel in the wizard page to end the import. Run the Converter from a computer running Windows NT to import the virtual machine or image.

The wizard shows which files it requires. The Next button remains disabled until every item has a check beside it.

5 Select the row in the File column, insert the media containing that file, and click Have Disk. Or, if you have the file available on your system or network, click Have Disk and browse to select the file.

The importer reads the file, and puts a check mark in the row if successful.

6 Repeat this for each required file, and when finished, click Next.

If the source virtual machine you’ve selected is password-protected, the Virtual Machine Login page appears.

7 Type the password and click Next.

If the source virtual machine is not password-protected, the wizard skips this page and presents the Source Data page.

8 To import all disks unchanged, make sure the Import all disks and maintain size radio button is selected on the Source Data page and click Next.

If you are creating a linked clone, you must use the Import all disks option. Import all disks is the only choice if the virtual machine you are importing has a Linux guest operating system.

Otherwise, select the Select volumes and resize to save or add space radio button and follow the remaining steps in this procedure.

9 Deselect any volumes you do not want to import.

If you deselect the system volume or active volume, a warning appears before you go to the next page.

10 Specify the volume size you want in the New Disk Space drop-down combo box, and click Next.

The choices are:

- **Maintain Size** (<size from Total Size column>) – Choose to keep the original volume size.

- **Min[imum] Size** (<size from Used column, plus a little additional>) – Choose to import just the used portion from the volume, with a small amount of space added.

- **<Type Size in GB>** – Choose to enter a specific size in gigabytes.

- **<Type Size in MB>** – Choose to enter a specific size in megabytes.

Typing in a value less than the minimum size results in a warning message.

Continue with “Step 2: Choosing a Destination for the New Virtual Machine”.

**Step 2: Choosing a Destination for the New Virtual Machine**

After you have specified your source using the pages collected under Step 1, choose from two categories of virtual machine for your destination. Depending on your destination, go to one of the following sections:

- “Importing Your Source Machine as an ESX Server Virtual Machine” on page 31
- “Importing Your Source Machine as a Workstation Virtual Machine” on page 32
Importing Your Source Machine as an ESX Server Virtual Machine

Follow these steps if you are importing the virtual machine to run in ESX Server or in ESX Server managed by VirtualCenter.

To select the destination for your converted virtual machine

1. Click Next on the Destination header page to move to the Destination Type page.
2. Select the VMware ESX Server or VirtualCenter virtual machine radio button and click Next.
3. In the Destination Login page, log on to its destination server and click Next.

   **ESX or VirtualCenter Server Login** – Identify which server receives the new virtual machine and how to gain access to that server. Choose the destination server from those presented in the drop-down box or type in the name of the server if it is not listed. Type your user name and the password for the destination server.

   If you chose an ESX Server, continue with the next step. If you chose a VirtualCenter server, go to Step 5.

4. In the Virtual Machine Name page, enter the name you want to assign to the virtual machine, and click Next and go to Step 8.

   If a virtual machine with the same name exists in the ESX Server, VMware Converter displays a warning message and asks you to select another name.

5. In the Virtual Machine Name and Folder page, enter the name you want to assign to the virtual machine.

6. Because you have selected a VirtualCenter server as the destination, you must choose a folder within the VirtualCenter inventory. Click Next.

   Unlike an ESX Server host, the VirtualCenter inventory might contain multiple hosts, clusters, and datacenters.

7. Specify the resources for the imported virtual machine in the Host or Cluster page and click Next.

   You select the host, cluster (for VirtualCenter Servers only), or resource pool within a host or cluster from which to run the virtual machine. If you select a cluster in manual mode, go to the next step to choose a host on that cluster. Otherwise, go to Step 9.

8. In the Host page, choose the specific host for the virtual machine (cluster in manual mode only) and click Next.

9. Specify the datastore for the virtual machine’s configuration files and disks, and click Next.

   All datastores and their available space appear in this panel. You must choose a datastore or datastores big enough to contain the selected disks.

   To distribute the disks over several datastores, click Advanced>> to see the list of disks and the virtual machine configuration file. Choose the datastore for each disk and file from the drop-down menus. If there is not enough space, an error message appears stating the required amount.
10 Map the virtual machine’s network adapters to a VirtualCenter network in the Networks page, and click Next.

The Networks panel displays in drop-down menus the networks available at the destination location. The number of adapters to map can be set in a drop-down menu as well.

Continue with “Step 3: Customizing the Guest Operating System of the New Virtual Machine (optional)” on page 34. If you do not want to customize the new virtual machine, you must go through the Customization page in Step 3 to indicate that you do not.

**Importing Your Source Machine as a Workstation Virtual Machine**

Follow these steps if you are importing the virtual machine to run in Workstation 4 or 5, VMware Player, VMware Server, VMware ACE 1.x, or GSX Server.

**To select the destination for your converted virtual machine**

1. Click Next on the Destination header page to move to the Destination Type page.

2. Select the **VMware standalone virtual machine** radio button and click Next.

3. In the VM Name & Location page, type a name for the imported virtual machine and browse to enter the destination location.

   If the source is a remote physical machine, you see a **Connect As** button. Specify a network-mountable location accessible to both the source machine and the machine running the Converter application.

4. Select the type of virtual machine you want to create: one that works with Workstation 5x0, VMware Server, and VMware Player, or one that works with Workstation 4.x, VMware ACE 1.x, and GSX Server 3.x.
5 Click Next.

6 Select the import options for a full clone, if available, and click Next. go to Step 8.

Depending on the type of source and destination, you might have options in how you allocate disk space for the new virtual machine:

- To allocate all the disk space for this clone, select the **Allocate all disk space now for better performance** radio button. This option gives somewhat better performance for your virtual machine. If you select the other radio button, the virtual disk's files start small and grow as needed, until they reach the size of the source disks from which they were cloned.

- To support virtual disks on FAT file systems, ensure that the **Split disk into 2 GB files** check box is selected.
7  For Workstation-to-Workstation conversions, select the import options for the new virtual machine on the Virtual Machine Options page and click Next.

Depending on the type of source and destination, you might have two choices for the way in which the importer creates the clone:

- **Create a full clone** – Creates a VMware virtual machine with no dependencies on the original virtual machine or system image. To allocate all the disk space for this clone, select the **Allocate all disk space now for better performance** radio button. If you select the other radio button, the virtual disk’s files start small and grow as needed, until they reach the size of the source disks from which they were cloned.

To support virtual disks on FAT file systems, select the **Split disk into 2 GB files** check box.

**NOTE** The **Allocate all disk space now for better performance** option creates a disk file that can be larger than the used space of the source. For example, the source disk might be a 16GB disk of which only 2GB is used for the file, but importing the file with the **Allocate** option creates a 16GB disk. Take this into account when you look at free space before you import.

- **Create a linked clone** – Creates a VMware virtual machine that shares the virtual disk of the source virtual machine or system image.

Linked clones are useful for proof-of-concept on a non-VMware image such as .sv2i and .vmc.

**NOTE** For linked clones, the virtual machine created by the importer is corrupted if the source is modified after the import. This is true for linked clones imported from Virtual PC and Virtual Server machines and from LiveState images. In the case of Virtual PC and Virtual Server source virtual machines, the act of powering the source virtual machines on in Virtual PC or Virtual Server modifies them, and corrupts the linked clones.

8  In the Destination Name and Location page, enter the name you want to assign to the virtual machine (cannot be greater than 80 characters).

9  Browse or type the path of the location where you want to create the VMware virtual machine and click Next.

10  Map the virtual machine’s network adapters to a bridged, host-only, or NAT network in the Networks page, and click Next.

Continue with “Step 3: Customizing the Guest Operating System of the New Virtual Machine (optional)” on page 34. If you do not want to customize the new virtual machine, you must go through the Customization page in Step 3 to indicate that you do not.

### Step 3: Customizing the Guest Operating System of the New Virtual Machine (optional)

This step enables you to install VMware Tools and customize the identity of the new virtual machine, install VMware Tools only, or neither install VMware Tools nor customize the virtual machine identity.

Customizing includes the ability to:

- Change the computer information for identifying the virtual machine on a network.
- Enter server license information.
- Change the time zone for the virtual machine.
- Modify the properties for each network interface.

**To customize the identity of the new virtual machine**

1  On the Customization page, select **Customize the identity of the new virtual machine** and click Next.

The table of contents expands to show the topics in this section of installation.
Chapter 4 Importing Machines with VMware Converter

2 In the Computer Information page, enter the new computer name and related information and click **Next**.

- **Computer Name** – A unique name to identify the virtual machine on the network. Valid characters include A-Z, a-z, 0-9, and the hyphen. Underscore is nonstandard, but VMware Converter permits its use. There is a 63-character limit.
- **Owner Name** – Valid characters include all printable characters; 63-character limit.
- **Organization** – Valid characters include all printable characters; 63-character limit.
- **Generate New Security ID (SID)** – Select to generate a new security identity.
- **Location of Sysprep Files** – If the application has determined this location, the text edit box shows it. If this field is blank, you must specify a valid location before going to the next panel.

3 Enter the Windows licensing information for this virtual machine, if necessary, on the Windows License page, and click **Next**.

You can leave the **Product ID** field blank and move to the next page.

The **Include Server License Information** check box applies only to Microsoft Windows 2000 Server and Microsoft Windows 2003 Server operating systems. The **Server License Mode** radio buttons are disabled if the check box is not selected.

4 Choose a time zone from the drop-down box in the Time Zone page and click **Next**.

If network interfaces need to be set, the Network Interface Settings page appears. Continue with the next step. If they do not need to be set, the page does not appear. Go to Step 8.

5 To customize your network adapter settings, choose the adapter on the Network Interface Setting page and click **Customize**.

If you prefer to use the default settings, click **Next** and go to Step 8.

The **Reset All** button is enabled if one or more network adapter has been modified. Click this button to return all settings for all adapters to the default.

6 Use the Network Properties dialog box to modify the properties of each network adapter you want to change.

- **General** tab – Select whether to use DHCP to obtain an IP address automatically or to enter the IP addresses manually. Select whether to use DHCP to obtain a DNS server address automatically or to enter the DNS server addresses manually.
- **DNS** tab – Specify the DNS connections by entering DNS suffixes. For each DNS suffix you enter, click **Add**. If you are entering multiple DNS suffixes, use **Move Up** and **Move Down** to specify the order in which a virtual machine is to use the connections.
- **WINS** tab – Specify the primary and secondary WINS addresses by typing the IP addresses in the entry boxes.

7 Click **OK** to return to the Network Interface Setting page, and click **Next**.

8 On the Workgroup or Domain page select how the virtual machine participates in a network, and click **Next**.

- **Workgroup** – Valid characters include A-Z, a-z, 0-9, space, and the hyphen. Maximum length is 15 characters.
- **Windows Server Domain** – The text box must have a value. Valid characters include A-Z, a-z, 0-9, space, period (dot), and the hyphen. Each label delineated by a dot can be 63 characters long, and the whole text string can be up to 254 characters long. A user name and password are also required.

Continue with “Completing the Import Task Creation” on page 36.
To customize the identity of the new virtual machine and to install VMware Tools on it (ESX Server and VirtualCenter destinations only)

1. On the Customization page select **Install VMware Tools** and click **Next**.
2. Follow the steps in “To customize the identity of the new virtual machine” on page 34.
   Continue with “Completing the Import Task Creation” on page 36.

To install VMware Tools only (ESX Server and VirtualCenter destinations only)

On the Customization page, ensure that the **Install VMware Tools** check box is selected and the **Customize the identity of the new virtual machine** check box is not selected. Click **Next**.

Continue with “Completing the Import Task Creation” on page 36.

To skip customization and not install VMware Tools

On the Customization page, ensure that the **Install VMware Tools** check box is deselected and click **Next**.

Continue with “Completing the Import Task Creation” on page 36.

**Completing the Import Task Creation**

The final page in the conversion wizard is the Ready to Complete page. Some differences exist depending on whether the converted virtual machine is for use with ESX Server or if the source machine is a remote one.

Click **Finish** to close the wizard and display the Task View with the conversion job in the task list. You can view the progress in the **Task Progress** tab.

Users of the Enterprise and Starter editions of VMware Converter can return to a queued job and edit the settings. See Chapter 7, “Managing Tasks.” Starter edition users can convert only one machine at a time, however.

To complete the task creation if the destination machine is an ESX Server machine

Review the summary of the settings for the new virtual machine. To have the new virtual machine powered on after the conversion is completed, select **Power on the new Virtual Machine after creation**. Click **Finish**.

To complete the task creation if the source machine is remote

If the source machine is remote, it must be rebooted to remove the VMware Converter Agent installed on it.

1. Review the summary of the settings for the new virtual machine. Click **Finish**.
2. On the Warning: Reboot Source Machine dialog box, click **Yes** to reboot the source machine.

To complete the task creation for all other cases

Review the summary of the settings for the new virtual machine. Click **Finish**.
This chapter describes how to cold-clone a local physical machine to a variety of destinations. Cold cloning with the VMware Converter Boot CD is available in the Enterprise edition only.

For local and remote hot cloning, see Chapter 4, “Importing Machines with VMware Converter.”

For configuring virtual machines and system images, see Chapter 6, “Configuring VMware Virtual Machines.”

This chapter includes the following sections:

- “Cold Cloning and the Converter Boot CD” on page 37
- “Starting the Wizard for a Conversion” on page 37
- “Step 1: Selecting Your Source Data” on page 38
- “Step 2: Choosing a Destination for the New Virtual Machine” on page 39
- “Step 3: Customizing the Guest Operating System of the New Virtual Machine (optional)” on page 40
- “Completing the Import Task Creation” on page 42
- “Using peTool to Modify the Converter Boot CD” on page 42

Cold Cloning and the Converter Boot CD

Because the source physical machine in a cold clone cannot be running its operating system—the definition of a “cold clone”—the operating system on which to run VMware Converter has to come from somewhere else. This is the function of the Boot CD. Booting from the CD runs VMware Converter on its own copy of WinPE, which uses the physical machine’s memory for drivers and such during the cloning task. Rebooting the physical machine after the migration removes all traces.

Starting the Wizard for a Conversion

Follow these steps to start the VMware Converter import wizard from the VMware Converter Boot CD.

To boot off the CD, set options, and start the application

1. Insert the Converter Boot CD in the source machine and restart the computer.
2. Within 10 seconds, press any key to boot into the operating system on the CD.
3. Optionally, in the Network Configuration dialog box, change the location for the temporary files, including the logs.
   By default, temporary files are stored in RAM disk. After the VMware Converter application is launched, the directory for temporary files can not be modified.
4. The VMware Converter application launches.
To specify a static IP address or map network drives

1. Choose Administration > Network Configuration in the main menu.
2. Select the appropriate radio button on the Network Properties tab to enter the static addresses. Click Apply.
3. Click the Network Drives tab and map the drives to the network share.
4. Click Connect.
   
   If necessary, enter the DOMAIN\user name and password to connect to a specific network share and click OK.
5. Click OK to return to the application.

To start the wizard

1. Click Import Machine in the upper left part of the toolbar.
2. Click Next on the Welcome to the VMware Converter Import Wizard page.

   The Source page introduces the Table of Contents pane. Converter combines its procedures under three sections (“Steps”): “Step 1: Source,” “Step 2: Destination,” and Step 3: Customization.” When you proceed to a section (“Step”), that section expands to display the names of the pages the wizard leads you through. When you are finished with that “Step” section, the next expands.

Continue with “Step 1: Selecting Your Source Data”.

Step 1: Selecting Your Source Data

After you start the wizard, you next can choose which of the source machine’s volumes to import and to indicate the size you want them to be in the new virtual machine. You can also import all disks unchanged.

To choose the disks or volumes to import

1. On the Source page, click Next to move on to the Source Data page.
2. To import all disks unchanged, make sure the Import all disks and maintain size radio button is selected on the Source Data page and click Next. This is the only choice if the virtual machine you are importing has a Linux guest operating system.
   
   Otherwise, select the Select volumes and resize to save or add space radio button and follow the remaining steps in this procedure.
3. Deselect any volumes you do not want to import.
   
   If you deselect the system volume or the active volume, a warning appears before you go to the next page.
4. Specify the volume size you want in the New Disk Space drop-down combo box, and click Next.
   
   The choices are:
   
   - **Maintain Size** (<size from Total Size column>) – Choose to keep the original volume size.
   - **Min[imum] Size** (<size from Used column, plus a little additional>) – Choose to import just the used portion from the volume, with a small amount of space added.
   - **<Type Size in GB>** – Choose to enter a specific size in gigabytes.
   - **<Type Size in MB>** – Choose to enter a specific size in megabytes.

   Typing in a value less than the minimum size results in a warning message.

Continue with “Step 2: Choosing a Destination for the New Virtual Machine” on page 39.
Step 2: Choosing a Destination for the New Virtual Machine

After you specify your source data using the pages collected under Step 1, choose from two categories of virtual machine for your destination. Depending on your destination, go to one of the following sections:

- “Importing Your Source Machine as an ESX Server Virtual Machine” on page 39
- “Importing Your Source Machine as a Workstation Virtual Machine” on page 40

Importing Your Source Machine as an ESX Server Virtual Machine

Follow these steps if you are importing the virtual machine to run in ESX Server or in ESX Server managed by VirtualCenter.

To select the destination for your converted virtual machine

1. Click Next on the Destination header page to move to the Destination type page.
2. Select the VMware ESX Server or VirtualCenter virtual machine radio button and click Next.
3. In the Destination Login page, log on to its destination server and click Next.

ESX or VirtualCenter Server Login – Identify which server receives the new virtual machine, and how to gain access to that server. Choose the destination server from those presented in the drop-down box or type in the name of the server if it is not listed. Type your user name and the password for the destination server.

If you chose an ESX Server, continue with the next step. If you chose a VirtualCenter server, go to Step 5.

4. In the Virtual Machine Name page, enter the name you want to assign to the virtual machine, and click Next and go to Step 8.

If a virtual machine with the same name exists in the ESX Server, VMware Converter displays a warning message and asks you to select another name.

5. In the Virtual Machine Name and Folder page, enter the name you want to assign to the virtual machine.

6. Because you have selected a VirtualCenter server as the destination, you must also choose a folder within the VirtualCenter inventory. Click Next.

Unlike an ESX Server host, the VirtualCenter inventory might contain multiple hosts, clusters, and datacenters.

7. Specify the resources for the imported virtual machine in the Host or Cluster page and click Next.

You select the host, cluster (for VirtualCenter Servers only), or resource pool within a host or cluster from which to run the virtual machine. If you select a cluster in manual mode, go to the next step to choose a host on that cluster. Otherwise, go to Step 9.

8. In the Host page, choose the specific host for the virtual machine (cluster in manual mode only) and click Next.

9. Specify the datastore for the virtual machine’s configuration files and disks, and click Next.

All datastores and their available space appear in this panel. You must choose a datastore or datastores big enough to contain the selected disks.

To distribute the disks over several datastores, click Advanced>> to see the list of disks and the virtual machine configuration file. Choose the datastore for each disk and file from the drop-down menus.

10. Map the virtual machine’s network adapters to a VirtualCenter network in the Networks page, and click Next.

The Networks panel displays in drop-down menus the networks available at the destination location. The number of adapters to map can be set in a drop-down menu as well.
Continue with “Step 3: Customizing the Guest Operating System of the New Virtual Machine (optional)”. If you do not want to customize the new virtual machine, you must go through the Customization page in Step 3 to indicate that you do not.

**Importing Your Source Machine as a Workstation Virtual Machine**

Follow these steps if you are importing the virtual machine to run in Workstation 4 or 5, VMware Player, VMware Server, or GSX Server.

**To select the destination for your converted virtual machine**

1. Click Next on the Destination header page to move to the Destination Type page.
2. Select the **VMware standalone virtual machine** radio button and click Next.
3. In the VM Name & Location page, type a name for the imported virtual machine and browse to enter the destination location.
4. Select the type of virtual machine you want to create: one that works with Workstation 5x0, VMware Server, and VMware Player, or one that works with Workstation 4.x, VMware ACE 1.x, and GSX Server 3.x.
5. Click Next.
6. Select the import options for a full clone, if available.

Depending on the type of source and destination, you might have options in how you allocate disk space for the new virtual machine:

- To allocate all the disk space for this clone, select the **Allocate all disk space now for better performance** radio button. This option gives somewhat better performance for your virtual machine. If you select the other radio button, the virtual disk's files start small and grow as needed, until they reach the size of the source disks from which they were cloned.

- To support virtual disks on FAT file systems, ensure that the **Split disk into 2 GB files** check box has been selected.

**NOTE** The **Allocate all disk space now for better performance** option creates a disk file that can be larger than the used space of the source. For example, the source disk might be a 16GB disk of which only 2GB is used for the file, but importing the file with the **Allocate** option creates a 16GB disk. Take this into account when you look at free space before you import.

7. Click Next.
8. In the Destination Name and Location page, enter the name you want to assign to the virtual machine (cannot be greater than 80 characters).
9. Browse or type the path of the location where you want to create the VMware virtual machine and click Next.
10. Map the virtual machine’s network adapters to a bridged, host-only, or NAT network in the Networks page, and click Next.

Continue with “Step 3: Customizing the Guest Operating System of the New Virtual Machine (optional)”. If you do not want to customize the new virtual machine, you must go through the first page in Step 3 to indicate that you do not.

**Step 3: Customizing the Guest Operating System of the New Virtual Machine (optional)**

This step enables you to install VMware Tools and customize the identity of the new virtual machine, install VMware Tools only, or neither install VMware Tools nor customize the virtual machine identity.
Customizing includes the ability to:

- Change the information for identifying the virtual machine on a network.
- Enter server license information.
- Change the time zone for the virtual machine.
- Modify the properties for each network interface.

**To customize the identity of the new virtual machine**

1. On the Customization page select **Customize the identity of the new virtual machine** and click Next. The table of contents expands to show the topics in this section of customization.

2. In the Computer Information page enter the new computer name and related information and click Next.

   - **Computer Name** – A unique name to identify the virtual machine on the network. Valid characters include A-Z, a-z, 0-9, and the hyphen. Underscore is nonstandard, but VMware Converter permits its use. There is a 63-character limit.
   - **Owner Name** – Valid characters include all printable characters; 63-character limit.
   - **Organization** – Valid characters include all printable characters; 63-character limit.
   - **Generate New Security ID (SID)** – Select to generate a new security identity.
   - **Location of Sysprep Files** – If the application has determined this location, the text edit box shows it. If this field is blank you must specify a valid location before going to the next panel.

3. Enter the Windows licensing information for this virtual machine, if necessary, on the Windows License page, and click Next. You can leave the **Product ID** field blank and move to the next page.

   The **Include Server License Information** check box applies only to Microsoft Windows 2000 Server and Microsoft Windows 2003 Server operating systems. The **Server License Mode** radio buttons are disabled if the check box is not selected.

4. Choose a time zone from the drop-down box in the Time Zone page and click Next. If network interfaces need to be set, the Network Interface Settings page appears. Continue with the next step. If they do not need to be set, the page does not appear. Go to Step 8.

5. To customize your network adapter settings, choose the adapter on the Network Interface Setting page and click **Customize**.

   If you prefer to use the default settings, click **Next** and go to Step 8. The **Reset All** button is enabled if one or more network adapter has been modified. Click this button to return all settings for all adapters to the default.

6. Use the Network Properties dialog box to modify the properties of each network adapter you want to change.

   - **General** tab – Select whether to use DHCP to obtain an IP address automatically or to enter the IP addresses manually. Select whether to use DHCP to obtain a DNS server address automatically or to enter the DNS server addresses manually.
   - **DNS** tab – Specify the DNS connections by entering DNS suffixes. For each DNS suffix you enter, click **Add**. If you are entering multiple DNS suffixes, use **Move Up** and **Move Down** to specify the order in which a virtual machine is to use the connections.
   - **WINS** tab – Specify the primary and secondary WINS addresses by typing the IP addresses in the entry boxes.

7. Click **OK** to return to the Network Interface Setting page, and click **Next**.
8 On the Workgroup or Domain page select how the virtual machine participates in a network, and click Next.
   - **Workgroup** – Valid characters include A-Z, a-z, 0-9, space, and the hyphen. Maximum length is 15 characters.
   - **Windows Server Domain** – The text box must have a value. Valid characters include A-Z, a-z, 0-9, space, period (dot), and the hyphen. Each label delineated by a dot can be up to 63 characters long, and the whole text string can be up to 254 characters long. A user name and password are also required.

Continue with “Completing the Import Task Creation” on page 42.

**To customize the identity of the new virtual machine and to install VMware Tools on it (ESX Server and VirtualCenter destinations only)**

1 On the Customization page select **Install VMware Tools** and click Next.
2 Follow the steps in “To customize the identity of the new virtual machine” on page 41.

Continue with “Completing the Import Task Creation” on page 42.

**To install VMware Tools only (ESX Server and VirtualCenter destinations only)**

On the Customization page, ensure that the **Install VMware Tools** check box is selected and the **Customize the identity of the new virtual machine** check box is not selected. Click Next.

Continue with “Completing the Import Task Creation” on page 42.

**To skip customization and not install VMware Tools**

On the Customization page, ensure that the **Install VMware Tools** check box is deselected and click Next.

Continue with “Completing the Import Task Creation” on page 42.

**Completing the Import Task Creation**

The final page in the conversion wizard is the Ready to Complete page. Some differences exist depending on whether the converted virtual machine is for use with ESX Server or if the source machine is a remote one.

Click **Finish** to close the wizard and display the Task View with the conversion job in the task list. The conversion starts immediately. You can view the progress in the **Task Progress** tab. Because Boot CD does not support concurrent imports, you can convert only one machine at a time. See Chapter 7, “Managing Tasks.”

**To complete the import task creation if the destination machine is an ESX Server machine**

Review the summary of the settings for the new virtual machine. To have the new virtual machine powered on after the conversion is completed, select **Power on the new Virtual Machine after creation**. Click **Finish**.

**To complete the import task creation for all other cases**

Review the summary of the settings for the new virtual machine. Click **Finish**.

**Using peTool to Modify the Converter Boot CD**

VMware provides peTool as a custom tool for adding Windows drivers to the Converter Boot CD ISO image, along with other modifications. Using peTool, you can add storage device drivers and network device drivers. This operation takes the form:

```
petool -i <Conv_boot_cd.iso> -n <driver_folder_path>
```

to add a new network driver to the ISO image.

You can add executable binaries and VNC packages and perform the other actions listed in Table 5-1, “peTool Options,” on page 43.
## Table 5-1. peTool Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>-h [--help]</td>
<td>Produce help message</td>
</tr>
<tr>
<td>-i [--image]</td>
<td>Specify image file — Specifies the WinPE CD image to be modified. An example: -i c:\coldclone.iso. The original of the ISO image is saved with a .bak extension. In this example, it would be saved as coldclone.bak.</td>
</tr>
<tr>
<td>-b [--binary]</td>
<td>Add binary files — For adding executable binaries. Must be followed by one or more full paths and names of binary files. The binary file is copied to the \Programs directory.</td>
</tr>
<tr>
<td>-B [--start_binary]</td>
<td>Add binary files and automatically start — Similar to -b, except that the added binaries execute automatically when WinPE boots up the system.</td>
</tr>
<tr>
<td>-v [--vnc]</td>
<td>Add VNC package — Specifies a VNC package to be added. It is followed by an executable binary with the VNC package you want to start up (%&lt;relative_path&amp;filename&gt;, the same format as described in -P), and, optionally, followed by a %&lt;predefined_VNC_password&gt;. For example, -v c:\RealVNC\vnc4.exe%123. This copies the VNC package at c:\RealVNC and starts the vnc4.exe under the RealVNC directory after boot up. The password for VNC is 123. If you set this option: the firewall will be turned off, and the “press any key to boot from CD” option during bootup will be removed.</td>
</tr>
<tr>
<td>-p [--package]</td>
<td>Add software packages — This must be followed by one or more full paths and names of software packages. The packages are copied to the \Programs directory.</td>
</tr>
<tr>
<td>-P [--start_package]</td>
<td>Add software packages and automatically start — Specifies an executable binary, inside the package, that you want to start after boot up. The format is -P %&lt;software_package_directory&gt;%&lt;relative_path&amp;filename&gt;. For example, if the package you add is inside a directory called c:\RealVNC and the executable binary you want to start up is vnc4.exe under the RealVNC directory, specify -P c:\RealVNC\vnc4.exe.</td>
</tr>
<tr>
<td>-f [--disable_firewall]</td>
<td>Disable firewall — Disables the firewall after WinPE boots up.</td>
</tr>
<tr>
<td>-d [--storage_driver]</td>
<td>Add storage device drivers — Must be followed by one or more full directory paths that contain the target device drivers. Use this option to specify the drivers from ones you already have.</td>
</tr>
<tr>
<td>-n [--network_driver]</td>
<td>Add network device drivers — Must be followed by one or more full directory paths that contain the target device drivers.</td>
</tr>
<tr>
<td>-t [--tmp]</td>
<td>Specify a temporary directory — Specifies the temporary directory for peTool. If the directory does not exist, peTool creates it. Without this option specified, peTool chooses the default temp file indicated by Windows.</td>
</tr>
</tbody>
</table>
Follow the procedures in this chapter if you have VMware virtual machines whose disks have been populated by restoring from a backup of a physical host or by some other direct means of copying a virtual machine’s disks. Configuring such machines with VMware Converter enables them to boot in VMware products.

This chapter includes the following sections:

- “Starting the Configuration” on page 45
- “Customizing the Guest Operating System of the New Virtual Machine (optional)” on page 46
- “Completing the Configuration” on page 48

Starting the Configuration

For configuration, the source cannot be a physical machine. Configuration can be done only on files from a VMware standalone virtual machine or from an ESX Server or VirtualCenter virtual machine.

Starting the Wizard and Getting to Source Selection

Follow these steps to start the VMware Converter configuration wizard from the VMware Converter application.

To start the wizard

1. Launch the VMware Converter application.
2. Click Configure Machine in the upper left part of the toolbar.
3. Click Next on the Welcome to the VMware Converter Configure Wizard page.

Continue with “Selecting an ESX Server Virtual Machine as the Source,” or “Selecting a Standalone Virtual Machine as the Source” on page 46.

Selecting an ESX Server Virtual Machine as the Source

To select the source ESX Server virtual machine to configure

1. Start the wizard and click Next to go to the Source Type page.
2. Select the ESX Server or VirtualCenter machine radio button on the Source Type page and click Next.
3. On the Source Login page, type in or choose the ESX Server or VirtualCenter Server containing the virtual machine you want to configure.

The ESX / VC Server drop-down box is populated with the identifiers or locations of systems that have been logged in to previously. You can type in a new identifier.

If you chose an ESX Server machine, proceed to the next step. If you chose a VirtualCenter server, go to Step 6.
Choose the virtual machine you want to configure from the list of those found on the ESX Server machine you logged on to.

Click Next and go to “Customizing the Guest Operating System of the New Virtual Machine (optional).”.

Specify the source for your virtual machine in the VirtualCenter virtual machine inventory browser, and click Next.

You can search the browser through one of two views of the inventory—the default Hosts & Clusters view or the Virtual Machines & Templates view—in the View drop-down box.

Continue with “Customizing the Guest Operating System of the New Virtual Machine (optional).”.

## Selecting a Standalone Virtual Machine as the Source

Follow these steps if your source system is a standalone VMware virtual machine (that is, one that is a virtual machine from VMware Workstation 4 or 5, VMware Player, VMware Server, or VMware GSX Server).

**To select the source standalone virtual machine to configure**

1. Start the wizard and click Next to move on to the Source Type page.
2. Select the Standalone virtual machine radio button on the Source Type page, and click Next.
3. Browse for the source virtual machine or image from the Select Virtual Machine page, and click Next.
4. In the file browser, select the file for the machine you want to configure and click Open.
   - The file type choices are limited to VMware Workstation Files (*.vmx).
   - If the source virtual machine you’ve selected is password-protected, the Virtual Machine Login page appears.
5. Type the password and click Next.
   - If the source virtual machine is not password-protected, the wizard skips this page and presents the Customization page.

Continue with “Customizing the Guest Operating System of the New Virtual Machine (optional).”.

## Customizing the Guest Operating System of the New Virtual Machine (optional)

This step enables you to install VMware Tools and customize the identity of the configured virtual machine, install VMware Tools only, or neither install VMware Tools nor customize the virtual machine identity.

Customizing includes the ability to:

- Change the computer information for identifying the virtual machine on a network.
- Enter server license information.
- Change the time zone for the virtual machine.
- Modify the properties for each network interface.

**To customize the identity of the configured virtual machine**

1. On the Customization page, select Customize the identity of the new virtual machine and click Next.
   - The table of contents expands to show the topics in this section of installation.
2. On the Computer Information page, enter the new computer name and related information, and click Next.
   - **Computer Name** – A unique name to identify the virtual machine on the network. Valid characters include A-Z, a-z, 0-9, and the hyphen. Underscore is nonstandard, but VMware Converter permits its use. There is a 63-character limit.
   - **Owner Name** – Valid characters include all printable characters; 63-character limit.
Organization – Valid characters include all printable characters; 63-character limit.

Generate New Security ID (SID) – Select to generate a new security identity.

Location of Sysprep Files – If the application has determined this location, the text edit box shows it. If this field is blank you must specify a valid location before going to the next panel.

3 Enter the Windows licensing information for this virtual machine, if necessary, on the Windows License page, and click Next.

You can leave the Product ID field blank and move to the next page.

The Include Server License Information check box applies only to Microsoft Windows 2000 Server and Microsoft Windows 2003 Server operating systems, and the Server License Mode radio buttons are disabled if the check box is not selected.

4 Choose a time zone from the drop-down box in the Time Zone page and click Next.

If network interfaces need to be set, the Network Interface Settings page appears. Continue with the next step. If they do not need to be set, the page does not appear. Go to Step 8.

5 To customize your network adapter settings, choose an adapter on the Network Interface Settings page and click Customize.

If you prefer to use the default settings, click Next and go to Step 8.

The Reset All button is enabled if one or more network adapter has been modified. Click this button to return all settings for all adapters to the default.

6 Use the Network Properties dialog box to modify the properties of each network adapter you want to change.

- General tab – Select whether to use DHCP to obtain an IP address automatically or to enter the IP addresses manually. Select whether to use DHCP to obtain a DNS server address automatically or to enter the DNS server addresses manually.

- DNS tab – Specify the DNS connections by entering DNS suffixes. For each DNS suffix you enter, click Add. If you are entering multiple DNS suffixes, use Move Up and Move Down to specify the order in which a virtual machine is to use the connections.

- WINS tab – Specify the primary and secondary WINS addresses by typing the IP addresses in the entry boxes.

7 Click OK to return to the Network Interface Settings page, and click Next.

8 On the Workgroup or Domain page select how the virtual machine participates in a network. Click Next

- Workgroup – Valid characters include A-Z, a-z, 0-9, space, and the hyphen. Maximum length is 15 characters.

- Windows Server Domain – The text box must have a value. Valid characters include A-Z, a-z, 0-9, space, period (dot), and the hyphen. Each label delineated by a dot can be 63 characters long, and the whole text string can be up to 254 characters long. A user name and password are also required.

Continue with “Completing the Configuration” on page 48.

To customize the identity of the configured virtual machine and to install VMware Tools on it (ESX Server and VirtualCenter only)

1 On the Customization page select Install VMware Tools and click Next.

2 Select Customize the identity of the new virtual machine and click Next.

Continue with “To customize the identity of the configured virtual machine” on page 46.
**To install VMware Tools only (ESX Server and VirtualCenter only)**

On the Customization page, ensure that the **Install VMware Tools** check box is selected and the **Customize the identity of the new virtual machine** check box is not selected. Click **Next**.

Continue with “Completing the Configuration.”.

**To skip customization and not install VMware Tools**

On the Customization page, ensure that the Install VMware Tools check box is deselected and click Next.

Continue with “Completing the Configuration.”.

---

**Completing the Configuration**

The final page in the configuration wizard is the Ready to Complete page. Differences exist depending on whether the converted virtual machine is for use with ESX Server.

Click **Finish** to close the wizard and display the Task View with the conversion task in the task list. You can view the progress in the **Task Progress** tab.

Users can return to a queued task and edit the settings. See Chapter 7, “Managing Tasks.”

**To complete the conversion if the machine is an ESX Server machine**

Review the summary of the settings for the new virtual machine. To have the virtual machine powered on after the conversion is completed, select **Power on the new Virtual Machine after creation**. Click **Finish**.

**To complete the conversion for all other cases**

Review the summary of the settings for the new virtual machine. Click **Finish**.
Managing Tasks

VMware Converter provides a task manager for managing migrations and configurations. This can be for a single import, or for multiple, concurrent migrations in the Enterprise edition. After you have created a task using the converter wizard to set up how you want to import or configure a machine, you can use the Task View of VMware Converter Manager to manage the order of tasks and to limit the number of concurrent tasks, to edit the tasks, to look at the progress of a task, and more.

This chapter includes the following sections:
- “Multiple Tasks” on page 49
- “Task View” on page 49
- “Starting and Canceling Tasks” on page 52
- “Looking at Progress and the Logs” on page 53
- “Editing Tasks” on page 53
- “Managing How Tasks Run” on page 54

Multiple Tasks

The Enterprise edition of VMware Converter can run unlimited multiple concurrent conversions, but you can limit the number. While tasks are running, you can continue to add new tasks to the queue, edit tasks that haven’t started or have been cancelled, and fix tasks that failed.

Task View

The upper half of the task manager window is the Task View. In it you see the task list, containing information about the various tasks, and the toolbar, with which you can start the wizards and manage the tasks in the list.

Task List

The task list presents the following:
- **ID** – Unique system-generated identifier for the task.
- **Description** – Brief explanation of the task, based on how you set it up in the converter wizard. “Import a physical machine” is an example.
- **Source** – IP address, location, or other descriptor of the source machine or image.
- **Destination** – IP address, location, or other descriptor of the converted virtual machine.
- **Progress** – Percentage of completion that a task has attained.
- **Status** – State of the task. Five possible states exist:
  - **In Progress (Running)** – In the process of importing or configuring a machine.
- **Queued** – The task is scheduled to run as soon as possible, initially based on ID number and maximum number of concurrent tasks allowed. The position in the waiting queue is indicated after the “#.”
- **Failed** – The task was unsuccessful due to some error.
- **Completed** – The task was successful.
- **Cancelled** – The running or queued task was cancelled by the user of the system.

- **Start Time** – Date and time stamp when the task started running.
- **End Time** – Date and time stamp when the task was completed, cancelled, or failed.

Click on any of the headers in the task list to sort the list by that attribute.

**Toolbar**

The toolbar contains commands and buttons for you to use:

- **Import Machine** – Clicking this invokes the import wizard. See Chapter 4, “Importing Machines with VMware Converter,” on page 25.
- **Configure Machine** – Clicking this invokes the configuration wizard. See Chapter 6, “Configuring VMware Virtual Machines,” on page 45.
- **Cancel Task** (icon) – See “Canceling a Task” on page 52.
- **Start Task** (icon) – See “Starting a Task from the Task View (Forcing a Queued Task to Run)” on page 52.
- **Delete Task** (icon) – See “Deleting a Task” on page 52.
- **Filter By:** – See “Changing the Number of Tasks Displayed in the Task List” on page 55.
- **Run Order** – See “Changing the Run Order” on page 55.
Figure 7-1. The Converter Task Manager showing the Task View and the Details View.

Details View

When you select a task in the task list of the Task View, you can see details of that particular task in the Details View in the lower half of the screen. The Details View consists of two tabs: Summary and Task Progress.

Summary Tab

The Summary tab appears by default when you select a task in the task list. It shows a summary of the options and details pertaining to the selected task, as configured in the wizard. The information falls into three categories: Source system information, destination system information (not used in “Configure Machine” tasks), and destination customization.

An Edit link appears in the upper left corner of the Summary tab. You can use it to reopen the import or configure wizard to make modifications to the task. This link is available only if the task’s status is queued, failed, or cancelled. See “Editing a Task” on page 53.

Task Progress Tab

The Task Progress tab displays the steps involved in the conversion for that task, and the status of each step. For a task that is running, the tab shows which step is currently in progress and the time remaining for that step to complete. At the bottom is an estimated time to completion for the whole task.
Starting and Canceling Tasks

If no other tasks are in queue, a task starts immediately after finishing the steps in the conversion wizard. If there are other tasks in queue, a task is put at the end of the queue and can run as soon as it is able. In some cases that can be immediately, depending on the setting of the number of tasks that can run concurrently. See “Controlling the Number of Tasks Running Concurrently” on page 54.

You can change the run order for queued tasks, see “Changing the Run Order” on page 55. You can also force a queued task to run. See below.

Starting a Task from the Task View (Forcing a Queued Task to Run)

If you want to override the order of the queued tasks, or if you want override any limit on the number of tasks that can be run concurrently, you can force a queued task to run from the toolbar.

For Starter edition users, you can force only the first task to run.

To force a task to run

Choose the task in the task list of the Task View and click the Start Task button ( ) in the toolbar.

Canceling a Task

You can cancel a task in the queue or one in progress. After a task has been cancelled, it loses its place in the queue, displaying “- - -” for the Start Time in the task list and the time of cancellation in the End Time column.

Canceling a task in progress does not “suspend” it. Canceling a task backs out of the conversion and reverts the source machine to its original state. If you want to continue the task later, you can edit the task, but you must restart from the beginning. See “Editing a Task” on page 53.

To cancel a specific task

1 Choose the task in the task list of the Task View.
   Shift-click or control-click to choose more than one task.

2 Click the cancel button in the toolbar ( ).

Deleting a Task

The delete command removes a task from the task list. The command works on any task except for one in progress. A running task must be cancelled before it can be deleted.

It is also possible to clear all tasks from history, except for those currently running.

To delete a specific task

1 Choose the task in the task list of the Task View.
   Shift-click or control-click to choose more than one task.

2 Click the delete button in the toolbar ( ).
To clear all tasks from history

1. Choose Administration > Clear All Tasks in the main menu.
2. Click OK in the verification dialog box.

Looking at Progress and the Logs

VMware Converter displays the progress of tasks in the Task View and the Details View.
If problems arise that cause the task to fail, you can review information in the logs. Also, if you go in to edit a failed task, the edit wizard shows the particular problem areas. See “Editing a Failed Task” on page 54.

Viewing a Task’s Progress

Although you can get a general sense of a task’s progress by looking at its row in the task list of the Task View, you can get a more complete picture by viewing the Task Progress tab in the Details View.

To view a task’s progress in the Detail View

Choose the row in the task table for the task you want to view. The Task Progress tab for that task appears in the Detail View. See “Task Progress Tab” on page 51.

Exporting and Viewing the Log

You must export the log text file to read it or to be able to send a copy to VMware technical support.

To export a copy of the log file

1. Choose File > Export Logs in the main menu.
2. Save the log text files in the place you want using the Export Logs dialog box.
3. Open the log file with a text editor.

The following describe the recommended logs for you to look at and to send in to VMware support, if necessary.
UFAD logs:
- %WINDIR%\Temp\vmware-temp\vmware-converter*
- %WINDIR%\vmware-temp\vmware-converter* (in Windows NT)

Client logs:
- %TEMP%\vmware-temp\vmware-client*

Send these in to support using File > Export Logs. For Converter Boot CD, map a network drive using the network configuration tool (see Chapter 5, “Using the Converter Boot CD for Local Cold Cloning,” on page 37) and use File > Export Logs.

These also are the locations on the remote machine if you are running a remote hot clone. To send these logs from a remote machine to VMware support, you must manually zip them and send them in.

Editing Tasks

Only tasks with statuses of queued, completed, failed, or cancelled can be edited.

Editing a Task

As long as a task is not in progress you can use the editing wizard to change conversion settings. After you edit a task, it goes to the end of the queue. To move the task back up the queue, use the Run Order button in the toolbar. See “Changing the Run Order” on page 55.
Managing How Tasks Run

Controlling the Number of Tasks Running Concurrently

To set the number of tasks that can run concurrently

1 Choose Administration > Maximum Concurrent Tasks in the main menu.
2 In the Maximum Concurrent Tasks dialog box, choose or type the number you want, if you do not select Unlimited.
3 Click OK.

Editing a Failed Task

To edit a failed task has a few differences from editing a queued or cancelled task.

1 Choose the row in the task table for the task you want to edit.
   The Task Progress tab for that task appears in the Detail View.
2 Click on the Summary tab to display it.
3 Click on the Edit link in the Summary tab to launch the Converter edit wizard.
4 Select the page link that contains the information or settings you want to edit.
   Repeat as necessary.
   For minor edits you need deal with the specific pages only, and not the unaffected ones. However, in the case of a major edit—that is, one in which you change the source or destination—VMware Converter resets all the remaining pages in the procedure to their defaults. You must go through each remaining page to complete the import task creation.
5 Click Finish.

Managing How Tasks Run

VMware Converter provides a variety of options for how you can view tasks, and manage the running of them in the queue.
Changing the Run Order

You can change the order of tasks in the queue. When you are in the process of changing the run order, queued tasks do not start running.

To change the run order

1. Click the Run Order button in the toolbar.
2. In the Run Order dialog box, choose the task you want to move in the queue, and use the up or down arrow button to change its position.
   - You can also change a task's position by dragging and dropping it.
   - Shift-click or control-click to choose more than one task.
3. Click OK.

Changing the Number of Tasks Displayed in the Task List

After using VMware Converter for a length of time the number of tasks archived can grow to be very large. To minimize clutter in the task list you can lower the number of tasks that appear.

Tasks in progress and tasks in queue to run are not affected by this selection. They are always displayed in the task list.

To limit the number of archived tasks displayed in the Task View

1. Choose View > Tasks Displayed in the main menu.
2. Choose the level of display you want, using the Tasks Displayed dialog box, and click OK.
   - Choices are to show all tasks run in:
     - the last week (default setting)
     - the last two weeks
     - the last three weeks
     - the last month
     - the past

See also “Deleting a Task” on page 52.

Changing Which Tasks Are Displayed in the Task List

Another way you can display tasks in the task list is to filter the tasks by status. The options are:

- <No Filter>
- In Progress
- Queued
- Cancelled
- Failed
- Completed

To filter the tasks displayed in the Task View

1. Choose the Filter By drop-down box in the toolbar.
2. Choose the type of task you want to filter by.
3. You can choose more than one status to filter by.
   - The drop-down box displays <Multiple> when you are done.
If you filter out queued or in progress tasks, a warning message at the bottom of the Detail View reminds you that they are not being displayed.

If you have already limited the number of tasks displayed, any filter you choose is applied on top of that subset of tasks.
Glossary

A  ACE Manager (VMware ACE Manager)
   The program used by a VMware ACE administrator to create and update projects, virtual machines, and packages. See also VMware ACE.

B  BIOS (basic input/output system)
   Firmware that controls machine startup and manages communication between the CPU and other devices, such as the keyboard, monitor, printers, and disk drives.

   bridged networking
   In hosted products, a type of network connection between a virtual machine and the host's physical network. With bridged networking, a virtual machine appears to be an additional computer on the same physical Ethernet network as the host. See also host-only networking, NAT (network address translation).

C  child
   A managed entity grouped by a folder object or another managed entity. See also folder.

   clone
   (n.) A duplicate of a virtual machine. (v.) To make a copy of a virtual machine. When a clone is created, VirtualCenter provides an option for customizing the guest operating system of that virtual machine. Hosted products distinguish between full clones and linked clones. See also full clone, linked clone.

   cold cloning
   In VMware Converter, cloning a local physical machine while it is running in WinPE from the VMware Converter Boot CD, not from its own operating system. See also hot cloning.

   concurrent migrations
   In VMware Converter, the Task Manager's ability to direct the conversion and migration of multiple virtual machines at the same time.

   configuration
   See virtual machine configuration.

Converter Boot CD (VMware Converter Boot CD)
   In VMware Converter, the means by which a user can perform a local cold clone of a physical machine. When the physical machine is booted from the Converter Boot CD, the Converter application runs on WinPE, not the machine's operating system, and uses a RAM disk for its operations, leaving no footprint on the physical machine.

   current virtual machine
   (1) A virtual machine of the latest version supported by the product in use. See also legacy virtual machine.
   (2) In hosted products, the virtual machine that has focus in the service console.
customization
The process of applying new characteristic values to a virtual machine as it is being deployed from a template or cloned from another existing virtual machine. Customization options include changing the new virtual machine identification and network information.

D
datastore
Virtual representations of combinations of underlying physical storage resources in the datacenter. A datastore is the storage location (for example, a physical disk, a RAID, or a SAN) for virtual machine files.

destination
In VMware Converter, the machine to which one imports a virtual machine, whether migrated or converted from a physical machine.

destination virtual machine
In VMware Converter, the migrated virtual machine at its final location.

DHCP (Dynamic Host Configuration Protocol)
A communications protocol that enables dynamic addressing. The software relieves administrators of the task of assigning an IP address to each device that connects to a network.

disk mode
A property of a virtual disk that defines its external behavior (how the virtualization layer treats its data) but is completely invisible to the guest operating system. Available modes vary by product and include persistent mode (changes to the disk are always preserved across sessions), nonpersistent mode (changes are never preserved), undoable mode (changes are preserved at the user’s discretion), and append mode (similar to undoable, but the changes are preserved until a system administrator deletes the redo-log file).

DNS (Domain Name System)
An Internet data query service that translates host names into IP addresses. Also called “Domain Name Server” or “Domain Name Service.”

E
Ethernet switch
A physical switch that manages network traffic between machines. A switch has multiple ports, each of which can be connected to a machine or to another switch on the network. See also VMotion.

EULA (end user license agreement)
The software license that details any restrictions placed on users.

F
FAT
Acronym for file allocation table.

file
A container for raw data, such as text or an image.

folder
A managed entity used to group other managed entities. Folder types are determined by the kinds of child entities they contain. See also child.

full clone
A complete copy of the original virtual machine, including all associated virtual disks. See also linked clone.

G
growable disk
A type of virtual disk in which the disk space is not preallocated to its full size. Its files start out small in size and grow as data is written to the disk.
**guest operating system**
An operating system that runs inside a virtual machine. See also host operating system.

**host**
(1) A physical computer capable of running virtual machines. Also called the “host machine” or “host computer.” (2) In VMware Converter, the physical computer on which the VMware Converter software is installed.

**host agent**
Software that, when installed on a virtual machine host, performs actions on behalf of a remote client.

**host-based licensing**
In ESX Server software, one of two modes for licensing VMware software. License files reside on the host and feature availability is tied strictly to the host in which the file resides. See also server-based licensing.

**hosted products**
VMware products (including Workstation, VMware Player, VMware Server, VMware ACE, and Lab Manager) that run as applications on physical machines with operating systems such as Microsoft Windows or Linux. By comparison, ESX Server is a “bare-metal” product, which provides a thin software layer (the hypervisor) that enables it to run directly on the physical machine.

**host-only networking**
In hosted products, a type of network connection between a virtual machine and the host. With host-only networking, a virtual machine is connected to the host on a private network, which normally is not visible outside the host. Multiple virtual machines configured with host-only networking on the same host are on the same network. See also bridged networking, Converter Boot CD (VMware Converter Boot CD), NAT (network address translation).

**host operating system**
An operating system that runs on the host machine. See also guest operating system.

**hot cloning**
In VMware Converter, cloning a local or remote physical machine while it is running in its own operating system. See also cold cloning.

**hot fix**
An installable file that resets a user’s password, renews an expired virtual machine, or enables a copy-protected virtual machine to run from a new location.

**legacy virtual machine**
A virtual machine supported by the product in use but not current for that product. For example, in Workstation 5, you can use and create virtual machines for use in Workstation 4.x, GSX Server 3.x, or ESX Server 2.x, but new Workstation 5 features (such as clones, multiple snapshots, and teams) are not compatible with the legacy virtual machines.

**license file**
A text file determining the license mode and entitlement to licensed features.

**license key**
An encrypted block of text within a license file, determining entitlement to one specific licensed feature.

**license mode**
The method used for licensing VMware software. A license file can be located on an ESX Server host or on a license server. VirtualCenter Server uses server-based licensing. ESX Server licensing can be server-based or host-based at the option of the system administrator. See also host-based licensing, server-based licensing.
linked clone
A copy of the original virtual machine that must have access to the parent virtual machine’s virtual disks. The linked clone stores changes to the virtual disks in a separate set of files. See also full clone.

local cloning
Making a copy of a virtual machine residing in the system on which VMware Converter is running, or making a copy of the physical machine itself for conversion to a virtual machine. See also remote cloning.

LUN (logical unit number)
An identifier for a disk volume in a storage array.

migration
The process of moving a virtual machine between hosts. Unless VMotion is used, the virtual machine must be powered off when you migrate it. See also migration with VMotion, migration with VMware Converter.

migration with VMotion
The process of moving a virtual machine that is powered on and has met selected requirements, including the activation of VMotion on both the source and target hosts. When you migrate a virtual machine using VMotion, the operations of the virtual machine can continue without interruption. See also migration with VMware Converter.

migration with VMware Converter
The process of moving a virtual machine that is powered off from a local or remote host, while reconfiguring the file format, if necessary, to accommodate the destination machine. See also migration with VMotion.

NAT (network address translation)
In hosted networking, a type of network connection that enables you to connect your virtual machines to an external network when you have only one IP network address and that address is used by the host computer. If you use NAT, your virtual machine does not have its own IP address on the external network. Instead, a separate private network is set up on the host computer. Your virtual machine gets an address on that network from the VMware virtual DHCP server. The VMware NAT device passes network data between one or more virtual machines and the external network. It identifies incoming data packets intended for each virtual machine and sends them to the correct destination. See also bridged networking, Converter Boot CD (VMware Converter Boot CD), host-only networking.

NIC (network interface card)
An expansion board that provides a dedicated connection between a computer and a network. Also called a “network adapter.”

P2V Assistant (VMware P2V Assistant)
A product that enables users to convert physical machines to VMware virtual machines. Superseded by VMware Converter. See also VMware Converter.

physical disk
In hosted products, a hard disk in a virtual machine that is mapped to a physical disk drive or partition on the host machine. A virtual machine’s disk can be stored as a file on the host file system or on a local hard disk. When a virtual machine is configured to use a physical disk, VirtualCenter directly accesses the local disk or partition as a raw device (not as a file on a file system). See also virtual disk.

physical network
A network of physical machines (plus cabling, switches, routers, and so on) that are connected so that they can send data to and receive data from each other. See also virtual network.
**provisioning**
The process of creating a functioning virtual machine by assigning resources such as CPU, memory, and virtual hardware and then deploying a system image.

**raw disk**
See physical disk.

**remote cloning**
Making a copy of a virtual machine or a physical machine accessed over the network by VMware Converter. See also local cloning.

**SAN (storage area network)**
A large-capacity network storage device that can be shared among multiple VMware ESX Server hosts. A SAN is required for VMotion.

**server**
(1) A system capable of managing and running virtual machines. (2) A process capable of accepting and executing instructions from another process.

**server-based licensing**
A mode of licensing VMware software in which all license keys are administered by a license server, which manages a central license pool. Feature entitlement is checked out and returned on demand. See also host-based licensing.

**source**
In VMware Converter, the machine from which one imports or creates a virtual machine.

**source virtual machine**
In VMware Converter, the virtual machine to be imported, at its original location.

**standalone virtual machine**
A virtual machine that runs in Workstation, VMware Server, and VMware Player. Source virtual machines from Microsoft Virtual PC, Microsoft Virtual Server, and Symantec Backup Exec System Recovery images are also considered standalones. See also source virtual machine.

**task**
A managed object representing the state of a long-running operation.

**TCP (Transmission Control Protocol)**
A reliable transfer protocol used between two endpoints on a network. TCP is built on top of the Internet Protocol (IP). See also TCP/IP (Transmission Control Protocol/Internet Protocol).

**TCP/IP (Transmission Control Protocol/Internet Protocol)**
A set of protocols, the de facto language of the Internet, designed to enable communication between networks regardless of the computing technologies that they use. TCP connects hosts and provides a reliable exchange of data streams with guaranteed delivery. IP specifies the format of packets and handles addressing.

**template**
A master image of a virtual machine. This typically includes a specified operating system and a configuration that provides virtual counterparts to hardware components. Optionally, a template can include an installed guest operating system and a set of applications. Setting a virtual machine as a template protects any linked clones or snapshots that depend on the template from being disabled inadvertently. Templates are used by VirtualCenter to create new virtual machines. See also linked clone.
virtual disk
A file or set of files that appears as a physical disk drive to a guest operating system. These files can be on the host machine or on a remote file system. See also growable disk, physical disk.

virtual hardware
The devices that make up a virtual machine. The virtual hardware includes the virtual disk, removable devices such as the DVD-ROM/CD-ROM and floppy drives, and the virtual Ethernet adapter.

virtual machine
A virtualized x86 PC environment in which a guest operating system and associated application software can run. Multiple virtual machines can operate on the same host system concurrently.

virtual machine configuration
The specification of which virtual devices, such as disks and memory, are present in a virtual machine and how they are mapped to host files and devices. In VMware Converter, VMware virtual machines whose disks have been populated by restoring from a backup or by some other direct means of copying undergo configuration to enable them to boot in VMware products. See also virtual machine.

virtual machine configuration file
A file containing a virtual machine configuration. This .vmx file is created when you create the virtual machine. It is used to identify and run a specific virtual machine.

virtual memory
An extension of a system’s physical memory, enabled by the declaration of a page file.

virtual network
A network connecting virtual machines that does not depend on physical hardware connections. For example, you can create a virtual network between a virtual machine and a host that has no external network connections. You can also create a LAN segment for communication between virtual machines on a team. See also legacy virtual machine, template.

Virtual SMP
The technology that enables a virtual machine to do symmetric multiprocessing. Virtual SMP enables you to assign two virtual processors to a virtual machine on any host machine that has at least two logical processors.

VMotion
A feature that enables you to move running virtual machines from one ESX Server system to another without interrupting service. It requires licensing on both the source and target hosts. VMotion is activated by the VirtualCenter agent, and VirtualCenter Server centrally coordinates all VMotion activities. See also migration with VMotion.

VMware ACE
An assured computing environment that gives security administrators the ability to protect critical company resources against the risks presented by unmanaged PCs. End users install a simple client program that enables them to run a virtual machine. VMware ACE offers complete control of the hardware configuration and networking capabilities of an unmanaged PC, transforming it into an IT-compliant PC endpoint. VMware ACE can be used internally or remotely and can be connected or disconnected from the trusted network. See also ACE Manager (VMware ACE Manager).

VMware Converter
Software that enables users to convert physical machines to virtual machines and to migrate virtual machines between VMware products. VMware Converter can perform mass migrations and create VMware virtual machines from a number of third-party formats.

VMware Infrastructure
A software suite, including ESX Server and VirtualCenter, that virtualizes servers, storage, and networking and enables multiple unmodified operating systems and their applications to run
independently in virtual machines while sharing physical resources. The suite delivers comprehensive virtualization, management, resource optimization, application availability, and operational automation capabilities. See also Ethernet switch.

**VMware Player**
Free software that enables PC users to easily run any virtual machine on a Windows or Linux PC. VMware Player runs virtual machines created by VMware Workstation, GSX Server, or ESX Server and also supports Microsoft virtual machines and Symantec LiveState Recovery disk formats.

**VMware Server**
A free virtualization product for Windows and Linux servers. It enables users to quickly provision new server capacity by partitioning a physical server into multiple virtual machines.

**VMware Tools**
A suite of utilities and drivers that enhances the performance and functionality of your guest operating system. Key features of VMware Tools include some or all of the following, depending on your guest operating system: an SVGA driver, a mouse driver, the VMware Tools control panel, and support for such features as shared folders, drag-and-drop in Windows guests, shrinking virtual disks, time synchronization with the host, VMware Tools scripts, and connecting and disconnecting devices while the virtual machine is running.

**Workstation (VMware Workstation)**
Virtualization software for software developers, testers, and enterprise IT professionals. VMware Workstation runs multiple operating systems simultaneously on a single PC. Users can run Windows, Linux, NetWare, or Solaris in fully networked, portable virtual machines with no rebooting or hard drive partitioning required. VMware Workstation includes memory optimization and the ability to manage multitier configurations and multiple snapshots.
Index

A
adding an Enterprise license 23
adding drivers to the Converter Boot CD 42
Agent, See VMware Converter Agent

B
Booting CD
cloning with 13, 37
importable physical machines 18
memory requirements 18

C
canceling a task 52
changing an Enterprise license 23
changing number of tasks displayed 55
changing the run order 55
choosing destination 30, 39
clearing all tasks from history 52
clones
full 34
linked 34
cloning
by edition 10
cold, defined 11
defined 10
disk-based 15
example 11
example of local 13
hot, defined 11
local, defined 11
modes 14
physical machine 11
physical machine, cold 37
remote, defined 11
volume-based 14
clusters, specifying for destination 31, 39
cold cloning
defined 11
example 13
memory requirements 18
with Boot CD 13, 37
completing import task creation 36, 42
configuration, starting 45
configuring VMware virtual machines 45
controlling number of tasks running 54
converting machines
menu of procedures 26
physical machine 27
customizing the guest operating system 34, 40, 46

D
datastores 31, 39
deleting a task 52
destination
ESX Server 31, 39
two categories 30, 39
Workstation or other standalone 32, 40
Details View, the 51
disk-based cloning 15
DNS, specifying the connections 35, 41, 47
drivers, adding to the Converter Boot CD 42
duplicate ID 20

E
editing
failed task 54
task 53
Enterprise edition
adding a license 23
changing a license 23
differentiators from Starter edition 10
errors, viewing in the logs 53
ESX Server
as destination 31, 39
as source 28
ESX Server support 18
exporting the log 53

F
failed task, editing a 54
FAT file systems 33, 40
filtering tasks displayed 55
folder, location of application 22
forcing a queued task to run 52

G
GSX Server support 19
guest operating system, customizing 34, 40, 46
GUID Partition Table (GPT) disks 15
VMware Converter User's Manual

H
host system requirements 17
hosted product virtual machine as source 29
hot cloning
  defined 11
  example 11

I
import options for a standalone virtual machine 34
installing VMware Converter 21
install-less mode 25
Inventory view
  Hosts & Clusters 29, 46
  Virtual Machines & Templates 29, 46
ISO image, modifying with peTools 42

J
jobs, managing 15, 49

K
knowledge base, accessing 8

L
license, adding 23
live cloning. See hot cloning
local cloning
  defined 11
  example 13
  with Boot CD 13
log
  exporting and viewing 53
  location of 53

M
managing jobs 15
managing jobs with the Task View 15, 49
Master Boot Record (MBR) disks 15
maximum number of tasks 54
memory requirements for Boot CD 18
minimum space requirements 18
modes of cloning 14

N
network, same for source and destination machines 11
new features in VMware Converter 16
Norton Ghost 19

O
offline cloning. See cold cloning
operating system
  compatibility issues 17
  system that Boot CD runs on 18

P
P2V Assistant 9
physical machine
  as source 27
  cold cloning 37
physical machines that can be imported 18
ports required for conversion 20
procedures for converting machines 26
progress, viewing 53
push install 23

R
remote cloning
  defined 11
  example 11
removing VMware Converter 22
repairing VMware Converter 22
resources, specifying 31, 39

S
scripted install 23
settings affected by conversion 19
source
  ESX Server 28
  standalone virtual machine 29
space requirements, minimum 18
standalone virtual machine as source 29
Starter edition 10
starting the wizard
  for cold clone 37
  for configuration 45
  for conversion 26
  to edit a task 54
Summary Tab, the 51
support
  supported destinations 19
  supported sources 18
Symantec Backup Exec System Recovery 19
system images that can be converted 18
system reconfiguration 10
system requirements 17

T
table of contents pane 26, 38
task
  completing import creation 36, 42
  editing 53
  editing failed 54
Task List 49
task manager
canceling a task 52
clearing all tasks from history 52
deleting a task 52
delisting number of tasks displayed 55
details View 51
designing a queued task to run 52
forcing a queued task to run 52
clearing concurrent tasks 54
starting and canceling tasks 52
Summary tab 51
Task Progress tab 51
Task Progress tab, the 51, 53
Task View, managing migrations with 15, 49
tasks
filtering display of 55
maximum concurrent 54
run order 55
TCP/IP ports 20
technical support resources 8
toolbar 50

U
uninstalling older versions before installing 21
uninstalling VMware Converter 22
user groups, accessing 8
uses for VMware Converter 9

V
Version support 18
viewing a task's progress 53
viewing the log 53
virtual disks
on FAT file systems 33, 40
virtual hardware
CPU issues 20
disk device issues 20
Ethernet adapter issues 20
graphics card issues 20
virtual machine
destination on same network as source 11, 15
Virtual Machine Importer 9
virtual machines
configuring VMware 45
that can be converted 18
Virtual PC support 19
Virtual Server support 19
VirtualCenter support 19
VMware community forums, accessing 8
VMware Converter
default location of application folder 22
editions 10
installing 21
removing 22
repairing 22
uninstalling 22
uses 9
VMware Converter Agent
VMware Converter Boot CD
cold cloning with 13
modifying ISO image 42
VMware Player support 18
VMware Server support 19
VMware Tools 34, 40, 46
volume-based cloning 14

W
what's new in VMware Converter 16
Windows
cold clone requirements for Boot CD 18
operating systems that VMware Converter runs on 17
Windows Server Domain 35, 42
WINS, specifying the addresses 35, 41, 47
wizard table of contents pane 26, 38
Workstation
as destination 32, 40
as source 29
Workstation support 18